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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published September 2012. 

© 2012 Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 

Migrating from Deltek Sema4® to Deltek Vision® means that you will be moving the data in your 
current Sema4 database to a new Vision database, and then using Vision to manage that data 
and process the accounting, billing, project management, and reporting transactions that are vital 
to your business. While this may seem like a large undertaking at first glance, the whole process 
can be broken down into a number of very manageable steps—and, of course, the staff at Deltek 
is available to guide you and support your efforts throughout the entire process. 

These are the major steps in the migration process: 

 Work with a Vision consultant to develop a migration plan for your firm. As part of this 
step, determine which staff members need training, what type of training they need, and 
when the training should occur. 

 Install Vision. 

 Install the current version of Sema4 and install the Vision Data Migration Tool. 

 Complete the migration decisions that apply to your conversion situation and record 
those decisions in the Vision Data Migration Tool. Complete any other data preparation 
tasks that are required. 

 Run the pre-conversion Check Data utilities in the Vision Conversion module and resolve 
any problems they reveal. 

 Create a backup copy of your Sema4 data and the VIDATA folder used by the Data 
Migration Tool and submit them to your Vision consultant for the trial conversion. 

 Load the converted data into your Vision system and test it to ensure the conversion 
results are satisfactory. 

 Review the screens of the Data Migration Tool and update it if any changes are needed. 
Verify that it is complete and accurate for the final conversion. 

 Create a backup copy of your current Sema4 data and the VIDATA folder used by the 
Data Migration Tool and submit them to your Vision consultant for the final conversion. 

 Load the converted data into your Vision system and begin live processing in Vision. 

This list of steps is a general map of the migration process. In practice, some steps may overlap 
and each comprises a number of more specific tasks. 

About this Guide 

The primary purpose of the Deltek Sema4 to Deltek Vision Migration Guide is to serve as an 
information resource for those who are responsible for planning and carrying out the migration of 
your current Sema4 data to the Vision database. 

Your key resource for the migration process, however, is your Vision consultant. This guide is not 
intended to replace the knowledge and experience that person provides. Rather it is intended to 
supplement Vision consulting services and to repeat and reinforce the information you receive 
from your consultant. 

While this guide at least touches on all of the primary steps listed previously, its main focus is on 
the tasks necessary to prepare for, carry out, and verify the results of the conversion of your 
Sema4 data. 

 Chapter 1 offers a summary of what the data conversion does and an introduction to the 
primary steps in the conversion process. 
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 Chapter 2 covers the migration decisions. This chapter is the heart of this guide. We 
recommend that you read these chapters to prepare for the migration planning session 
you’ll have with your Vision consultant. After the planning session, as you are making and 
recording your decisions, refer to this chapter if you need to refresh your understanding 
of individual decisions. 

 Chapter 3 provides step-by-step instructions for using the Vision Data Migration Tool 
dialog boxes to record your migration decisions and for running the pre-conversion Check 
Data utilities to verify that your Sema4 data is prepared for conversion. Because the 
dialog boxes are not difficult to use in most cases, you may not need to refer to this 
chapter much as you are entering setup data. However, be sure you read the topic on 
running the pre-conversion utilities. That step in the migration process is crucial. 

 Chapter 4 describes how to begin using Vision and how to load and test the converted 
data. 

Planning and Management 

In our experience, the most important part of the migration process is the planning phase. An 
experienced Deltek consultant will act as your project manager and lead you through this phase, 
gathering information about your firm, and helping you design a migration plan. This consultant 
will remain in contact with your firm throughout the migration process, answering questions and 
providing training and guidance. 
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If You Need Assistance 

If you need assistance installing, implementing, or using Vision, Deltek makes a wealth of 
information and expertise readily available to you. 

Customer Services 

For over 20 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 
  

 
Find out more about these and other services from the Customer Care Connect site. 

  

Customer Care Connect Site 

The Deltek Customer Care Connect site is a support Web portal for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options you have at the Customer Care Connect site: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Subscribe to Deltek communications about your Deltek products and services 

 Receive alerts of new Deltek releases and hot fixes 
  

 If you need assistance using the Customer Care Connect site, the online help available on the site 
provides answers for most questions. 
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Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  

1. Go to https://deltek.custhelp.com.  

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 
  

 

If you do not have a username and password for the Customer Care Connect site, contact your firm’s 

Vision Administrator. 

If you forget your username or password, you can click the Account Assistance button on the login 

screen for help. 

  

https://deltek.custhelp.com/
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Chapter 1: Preparing for Migration 

Data Conversion Overview 

Deltek offers three data conversion options. These options differ primarily in the amount of 
historical data that is converted, and as a result, they also differ in pricing. 

Option Description 

Basic You can convert only the types of information that reside in the Deltek 
Vision Info Centers (such as projects, clients, vendors, employees). No 
transactions are converted. 

Standard You can convert both Info Center information and transactions. Brings 
over general ledger opening balances and not detail.   

Premium You can convert both Info Center information and transactions. Both 
general ledger opening balances and general ledger detail convert with 
this option. Also, any departments or office distinctions indicated by a 
prefix or suffix in your chart of accounts can be transferred to Vision as 
organizations. 

After you download the data migration tool, you select the conversion option in the second dialog 
of the Data Migration tool. Your conversion option selection automatically configures the tool 
accordingly. 

Selecting a Conversion Level 

If you have not already selected a conversion option, your Vision consultant will discuss the 
advantages and disadvantages of each of them with you. The basic tradeoff is between 
converting historical data and the time and expense of the conversion. 

In general, if you reduce the amount of data you convert, you also reduce the number of 
conversion problems, and you start with a “cleaner” database as you move forward with Vision. 

The following table summarizes the data that is and is not converted by each conversion option. 

Feature or Module Basic Standard Premium 

Info Centers: Chart of Accounts, Client, 
Vendor, Staff, Employee, 
Project/Phase/Task/Unit 

x x 

Does not convert 
Organizations and has less 
flexible WBS conversion 
than is provided with the 
Premium option. 

x 

Billing term and billing category  x x x 

Project labor   x x 

Project expenses   x x 

Project Invoices & Receipts   x x 

Accounts Payable   x x 

Employee Payroll Withholding x x x 
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Feature or Module Basic Standard Premium 

Employee Direct Deposit Information x x x 

YTD Payroll data   x x 

Beginning G/L Balances   x x 

Accrued benefits   x x 

Organizations (from Sema4 Dept./Office or 
Chart of Accounts) 

  x 

Full GL Transactions    x 

Bank reconciliation   x x 

AR comments  x x 

SF 254 x x x 

SF 255 x x x 

Employee Resumes Used for 254/255 forms x x x 

Vendor Resumes Used for 254/255 forms x x x 

Time records into Vision’s timesheet module    

Employee expense sheets into Vision’s 
expense module 

   

Recurring GL and AP transactions    

Copies of Invoices and other Sema4 reports    

Data That Isn’t Converted 

The conversion program moves much of your Sema4 data to Vision. However, because of the 
many differences between the two systems, some data is not converted. In many cases, just a 
few data items from Sema4 records aren’t converted, but in a few instances certain categories of 
data aren’t converted. Following are the more noteworthy examples: 

 Timesheets — The Vision Time application is an optional, separately priced Vision 
application for entering and processing timesheets. The standard Vision product does not 
use time sheets. Because the Time application is optional and because you can’t edit 
past time sheets in that application, the conversion converts Sema4 time records to 
posted Vision time records, but does not convert the sheet information. 

 Remote Time and Expense Records — The Vision Expense application is an optional, 
separately priced Vision application for entering and processing employee expense 
sheets. The standard Vision product does not use employee expense sheets. Because 
the Remote Time and Expense application is optional and because you can’t edit past 
time sheets in that application, the conversion converts Sema4 employee expense 
records to Vision, but does not convert the expense sheet information. 

 Invoices and Reports — No Sema4 reports, custom or standard, are available in Vision. 
After installing Vision, review the reports and identify those that contain the information 
you want. You have the option to convert the Sema4 invoice formats, custom or 
standard, that are assigned to the projects you are converting, but the conversion does 
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not result in identical invoices in Vision. It just provides you a starting point for setting up 
Vision invoices. Invoices processed through Sema4 display on AR reports in Vision, but 
do not display as available to reprint or preview from Vision’s Interactive Billing, Invoices 
on the File dialog. 

 Memorized Transactions — Recurring Purchase Journal invoices, purchase orders, 
general journal transactions, and cash receipts are not converted. 

 Billing Schedules — While a default rate table based on the rates in Employee Setup is 
created during conversion, there is no option to convert billing schedules. 

 Expense Rate Tables — No expense rate tables are converted.  While billing expense 
categories in Vision are similar, the correlation isn’t close enough to convert the expense 
rate tables from Sema4. 

 Past Years’ Payroll data — Only the current year’s payroll journals are converted to 
Vision. This is true for both standard and premium conversion types.  No past years’ 
payroll is converted. 

If You Have Multiple Sema4 Databases 

If you have multiple databases in Sema4, each database you want to convert to Vision goes 
through its own migration process. If you purchase the Vision Multicompany feature, your 
converted Sema4 data for all companies are merged into a single database. If you don’t enable 
the Multicompany feature, each company’s information goes into a separate database. 

Prepare Vision for the Migration 

You can convert your Deltek Sema4 data to Deltek Vision 5.1 or any later version of Vision. 

You must be on version 9.0 or 9.1 of Deltek Sema4 to convert to Deltek Vision 5.1. 

Hardware and Software Selection 

As part of the planning process, our Technical Services staff will help you choose and configure 
any new hardware or software you need in order to run Vision.  

We will evaluate your current equipment and determine your needs in the following areas: 

 Workstation requirements 

 SQL Server database requirements 

 Server requirements 

 Bandwidth requirements 

 Licensing requirements 

For more detailed information about Vision hardware and software requirements, and technical 
specifications for running the software, see the Deltek Vision Technical Installation Guide, which is available 
on the Vision Installation CD (in PDF format) from the Customer Care Connect site. 

Installing Vision 

Install Vision and the demonstration database as soon as you want to access Vision at your site. 
Do this before you send your Sema4 data to Deltek for conversion so you can load the Vision 
database as soon as it is available and begin verifying the conversion results. 

For complete instructions and a detailed explanation of the Vision installation process, see the 
Deltek Vision Technical Installation Guide, which is available on the Deltek Vision Installation CD 
(in PDF format) from the Customer Care Connect site. 
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During the Vision installation process, you will be asked to supply your database server name, 
your database name, your database username, and your database password. When you enter 
your database name, enter the name you gave to your newly converted database. 

After you install Vision, you must log on and activate the modules you purchased before you can 
begin using the application. You must also complete some configuration tasks. See Chapter 4 for 
details. 

To acquire the Sema4 to Vision Data Migration Tool, complete the following steps: 

1. Log on to the Customer Care Connect site. 

2. Click the Knowledge Center tab. 

3. In the Search text field, enter Sema4 to Vision Data Mapping. 

 

4. Click Search. KB # 38319 should appear on top of the resulting list of knowledge base 
entries. Alternatively, you can switch the Search by field to KB # and then type 38319 into 
the Search text field. The Summary of the knowledge base article serves as a link to that 
specific entry and opens the list of directions and a zipped copy of the data migration 
utility itself.   

 

5. Once the KB entry is opened, right-click the file attachment at the bottom to download the 
utility.  The attachment is circled in the picture below. 
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Plan the Migration 

Client Implementation  

Several functional areas will be involved in implementing Deltek Vision. Your team involved in 
planning and implementing the conversion consists of the following roles: 

Title Role 

Executive 
Sponsor 

The Executive Sponsor is the system champion/cheerleader/enforcer, responsible 
for securing commitment from executive management, department/office 
management, accounting, marketing, and project managers. 

The Executive Sponsor reviews the major decisions made about Vision and 
ensures that your firm’s needs have been met. 

Senior management support is perhaps the single most important aspect of a 
successful implementation. Vision is normally chosen because of a need to 
standardize processes to benefit from an end-to-end system. The Executive 
Sponsor must be involved in identifying and implementing changes to your internal 
processes to ensure that you get full benefit from the comprehensive nature of the 
Vision product. 

Coordinator The Coordinator has overall responsibility for the implementation of Vision software 
at your firm. The person in this role deals with issues relating to policy and 
procedures. The Coordinator ensures that all groups’ requirements are considered 
in the implementation decisions. 

The primary role of the Coordinator is as the firm’s high-level liaison between your 
firm and Deltek, and between all internal groups using management information 
generated by Vision. This individual, usually a senior-level manager, performs an 
integrative function, rather than providing technical expertise on Vision.  
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Title Role 

Application 
Administrator 

The Application Administrator develops a thorough understanding of the 
application through the implementation process with the Client Implementation 
Team and Deltek. Thereafter, this person performs the ongoing day-to-day 
administration of the system and leads the internal training effort. 

The role of the Application Administrator is primarily production-oriented. This 
individual must have an overall knowledge of Vision applications and operations 
(including Info Center maintenance, data entry, and report production). A basic 
understanding of accounting and project management principles is also required.  

The Application Administrator becomes the Vision resource for your firm, and 
advises principals, project managers, marketing, and the controller as they make 
decisions about the system. The responsibilities of this position do not typically 
include the use of Vision reports to make management decisions or the 
development of firm budgets or project budgets. 

To prepare for his or her responsibilities, the Administrator should participate in 
Administrator Training, Pilot Training, and User Training. 

Application 
Administrator 
(cont.) 

The Administrator serves as your primary contact with Deltek Support. Daily 
support questions from those using Vision should be routed first through the 
Administrator so that person can become familiar with the common questions and 
the specific needs of the users, and become the initial Vision resource for your 
employees. 

Information 
Systems 
Representative 

The Information Systems Representative is responsible for the day-to-day 
technical maintenance of Vision. A working knowledge of Windows technologies, 
including SQL Server and Internet Information Server are preferable. 

Project 
Management 
Representative 

The Project Management Representative is the liaison between the Coordinator 
and the project managers. This individual makes sure that the needs of project 
managers are communicated to the Coordinator and taken into consideration 
during installation. The Project Management Representative works with the Deltek 
consultant to develop specific training programs for the project management staff. 
He or she also participates in the training programs along with a Deltek consultant. 

Accounting 
Manager 

The Accounting Manager oversees the entry of accounting and project data into 
Vision. A large firm might have multiple Accounting Managers, each with an area 
of specialization (for example, billing, accounts payable, or payroll). 

Office/Division 
Administrator 
(optional) 

If your company has multiple offices or divisions, consider including a second tier 
of part-time Office/Division Administrators to provide input on any unique business 
needs of the individual offices or divisions. 

Planning Meeting 

To ensure that your migration goes as smoothly as possible, one of our experienced Vision 
consultants will meet with you to help you develop a migration plan. 

During the planning session, the consultant and your team will do the following: 

 Gather information from your senior managers, accounting staff, project managers, and 
marketing personnel to assess each group’s Vision requirements. 

 Review your current work breakdown structure (WBS) for projects, billing groups, phases, 
labor codes, accounts, vendors, clients, and employees to determine if changes would be 
beneficial. 

 Review the Vision release schedule. 
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 Demonstrate the Vision user interface. 

 Demonstrate Vision’s new features and reporting capabilities. 

 Analyze the differences between Vision and Sema4 to see how they will affect your firm. 

 Discuss how internal procedures might be improved to make the most of the features in 
Vision. 

 Discuss options for mapping and importing data stored in applications other than Sema4. 

 Help you create a data entry plan for Vision. 

 Review interfaces with other applications and determine how to maintain these interfaces 
in Vision. 

 Discuss the special responsibilities or roles that your staff must assume during the 
migration process. 

 Determine whether you need additional hardware or software to run Vision. 

 Discuss the steps you should take to prepare your Sema4 data for conversion. 

 Schedule the major phases in the migration process, including data preparation, 
conversion, and segment testing. 

 Choose the date you will begin processing “live” on Vision. 

 Determine whether your firm needs any custom reports or processes to supplement the 
standard options available in Vision. 

 Plan a training program for your staff. 

Prepare Sema4 for the Migration 

Install the Required Version of Sema4 

We recommend that you install the latest version before beginning the conversion process, so 
you can benefit from the latest enhancements to the conversion. 

While we strongly discourage converting to Deltek Vision from a version of Sema4 other than a 
required version, it is possible to do so if there is a compelling reason. However, that approach 
requires skilled IT resources, requires more time both from your staff and from your Vision 
consultant, and is more expensive. Contact your Vision consultant for more information on this 
option. 

Acquiring the Data Migration Tool 

When you purchase Vision, you are given directions on where to download the Sema4 Data 
Migration tool and instructions on the installation of the tool are available in the same location as 
the download itself. The Sema4 to Vision Migration tool stores the mapping decisions necessary 
for Deltek to convert your database. 

Make and Record the Migration Decisions 

After you’ve installed the required version of Sema4 and the Data Migration Tool, you’re ready to 
make the decisions about how you want your data converted and to record those decisions using 
the Data Migration Tool. The next few chapters describe why each of those decisions is 
necessary and provide guidelines for making the right decisions for your situation. 
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Run the Pre-conversion Utilities 

When you have finished using the Data Migration Tool to record the migration decisions that 
apply to your conversion and you have completed any additional data preparation tasks, the next 
step is to run a set of pre-conversion Check Data utilities to ensure that your Sema4 data and 
migration decisions are ready for the conversion. Do not submit your Sema4 data for conversion 
if you have not run all of these utilities and resolved as many of the data problems as you can. 
See “Error! Reference source not found.” in Chapter 3 for a description of this important step in 
the migration process. 

Run Sema4 Reports 

Deltek recommends that you run a set of selected reports just before you send your Sema4 data 
to your Vision consultant for conversion. When you receive the converted data, you can then print 
comparable reports in Vision and compare the two sets of reports to verify that the two systems 
balance. For a list of the reports and complete balancing instructions, see “Balancing Sema4 to 
Vision” in Chapter 4. 

Submit a Copy of Your Sema4 Database for Conversion 

A Vision consultant performs the actual data conversions. Normally, they do a trial conversion 
first so you can review the data in Vision. Once you are happy with the results, they perform a 
final conversion of your current Sema4 data. Your last task before the conversion is to make a 
backup copy of your Sema4 data and send it to the consultant. See “Sending your Data to Deltek 
for Conversion” in Chapter 3 for details. 

Convert Your Deltek Sema4 Database 

During the time you have been using Deltek Sema4 to process data, you have likely accumulated 
a huge store of information about your firm's finances, projects, clients, and employees. No doubt 
you’ll want to transfer this data from Sema4 into Deltek Vision as quickly and efficiently as 
possible so that you can start using Vision to process your firm’s business transactions. The time 
that Deltek has your data for conversion can vary from one to four days. 

To ensure the best conversion results, we require at least two conversions. A test conversion 
usually takes place a few months before the final conversion. The test conversion does the 
following: 

 Enables you to confirm that the way you have chosen to change your Sema4 data to fit 
with Vision features is optimal 

 Enables you to confirm that our conversion program works correctly with your data and 
that the resulting database is satisfactory 

 Provides you with an experimental database to use for testing and staff training. 

Final Conversion 

The final conversion takes place at the time you begin processing “live” on Vision. Picking the 
best date to go live takes careful planning. You will want to choose a date that minimizes the 
impact on your accounting and payroll processes, your billing cycle, and your reporting schedule. 
At least one day before your scheduled conversion, you will send your prepared Sema4 data to 
Deltek by either uploading it to the Deltek e-Support site or by sending it overnight to the Deltek 
consultant who is performing the conversion. 

Before running the conversion, the consultant reviews key elements of the data. There are also 
additional pre-conversion utilities the consultant runs to check the Sema4 data.  If you request 
that Deltek perform some of the pre-conversion steps, or if there are data problems that you are 
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unable to resolve on your own, the consultant also performs those tasks. He or she then runs the 
conversion to create the Vision SQL database. 

Data Verification 

Following the conversion, the Vision consultant prints key Sema4 and Vision reports and 
compares them to ensure that the data converted correctly. (You are encouraged to perform this 
check yourself when you receive the converted data. For instructions, see Introduction: 
Balancing Sema4 to Vision in Chapter 4 and the related topics that follow that one.) 

After verifying the data, the Vision consultant prepares a report indicating any differences found. 
This report is emailed to you along with notification that your Vision database is available on the 
e-Support site. You can then download and install the database. 

Load and Evaluate the Converted Data 

When you receive the test conversion data, you load it into your Deltek Vision database and 
evaluate it to ensure you selected the correct conversion option and to confirm that the data 
conversion was successful and satisfactory. 

In preparation for this step of the migration process, prepare a detailed testing plan with the help 
of your Vision consultant. The plan should include staff assignments for testing individual 
modules or processes, procedures for reporting problems, and a schedule for completing the 
testing and addressing any issues. 

The evaluation of the conversion results should include the following: 

 Comparing selected Deltek Sema4 and Vision reports to confirm that the two systems 
balance (see Chapter 4) 

 Verifying Info Center data (see Chapter 4) 

 Performing segment testing (see Chapter 4) 

Go Live on Deltek Vision  

As part of planning your migration to Deltek Vision, you must choose a “go live” date—the date on 
which you plan to stop using Deltek Sema4 and begin processing solely with Vision. The date you 
choose depends upon several factors: 

 Payroll, billing, and payment cycles 

 Staff availability (for example, holidays, other critical assignments) 

 Availability of data needed for cut-over 

In preparation for your “go live” date, you must restore the final conversion database and 
configure your application and security settings just as you did when you created your test 
database. 

You may be able to import some configuration and other settings from your test database into 
your live database. For example, you can copy security from the test database to the live Vision 
database. These steps are billable and must be arranged in advance with your Vision consultant. 

Because the go live date marks the beginning of “live” processing in Vision, you should not 
perform any processing in Sema4 after that date. 
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Chapter 2: Differences between Vision and Sema4 

This chapter discusses the significant differences you will encounter when converting your data 
from Sema4 to Vision. 

The chapter covers the following topics: 

 Work Breakdown Structure (WBS) 

 Account Breakdown Structure (ABS) 

 Job Cost 

 Overhead Allocation 

 Dates and Periods 

 Daily Accounting Entries 

 Revenue Generation 

 Billing 

Work Breakdown Structure (WBS) 

This section compares the following: 

 Levels of projects 

 Project types 

 Setting up projects 

 Project labels 

 WBS functionality 

WBS in Sema4 

Choose from three levels of projects when you set up a project in Sema4:  

 Project – You cannot change the project label. 

 Phase – You can change the phase label. 

 Task – You can change the task label. 

You do not need to enforce WBS setup in Sema4 in accounting transactions. It is possible to 
charge time, expenses, invoices and receipts to any desired level of the Work Breakdown 
Structure. For example, if a project is set up with a phase and multiple tasks, the time entry can 
go down to the task or just to the phase. In addition, time and expense can be entered on the fly 
as long as the phase or task exists in the generic tree. 

Setting up Projects 

You can set up projects in two separate places: Project Setup and Indirect Project Setup.  

 In Project Setup, you can choose whether the project is Direct or a Proposal. By setting 
up a project as a Proposal, you can also set whether the labor is shown as Direct or 
Indirect on productivity reports. All time charged against the Proposal project is assigned 
the status of H for hold. If you set up a project as a Proposal and the System File is set to 
treat proposal projects as in Direct projects, then all time charged against that project is 
considered Indirect. If you later decide to make that project a Direct project, you must 
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change it from Proposal to Direct. You also must change the status from H (hold) to R 
(ready to bill) or N (never bill), depending on whether you plan to bill the time recorded on 
the timesheets. 

 Indirect projects are used to track general overhead, vacation, sick leave, holidays, 
business development, and other overhead activities such as accounting, and civic duty. 

WBS in Vision 

When a project (level 1) is set up, you can choose from three charge types: regular, overhead, 
and promotional. The project's charge type determines: 

 The account number to use when entering data for the project. 

 The reports that show the data. 

In Vision, postings to the General Ledger are essentially project-driven. Many areas of Vision 
check for consistency between account numbers and project charge types. Regular projects must 
be associated with revenue, as well as billable and non-billable consultant and project expenses. 
Overhead and promotional projects must be associated with indirect expenses. 

In Vision, you can edit all WBS labels. 

Regular Projects 

Regular projects are revenue producing. Costs charged to regular projects include direct labor, 
direct expense (non-reimbursable expenses), and reimbursable expenses (billable consulting and 
reimbursable expenses). Detail is retained for the life of the project. 

Overhead Projects 

Overhead projects are not revenue producing. Costs charged to overhead projects include 
indirect labor and indirect expense. Typical overhead projects include general overhead, 
vacation, sick leave, holiday, business development, accounting, and civic duty. Overhead 
projects accumulate transactions for the current fiscal year, and the total cost of these projects is 
distributed to regular projects during overhead allocation. Unlike Sema4, Vision requires projects 
\for posting indirect expenses. For example, when entering a voucher to an expense account, you 
must assign a project number to the transaction. In some cases, you can set up default project 
numbers that are used automatically with certain transactions. 

Promotional Projects 

This is a type of overhead project that can accumulate transactions over multiple fiscal years. Use 
Promotional projects when you want to track the labor and expense incurred while acquiring a 
project. If the job is obtained, you can create a new Regular project. In Vision, you need to set up 
a new Regular project to track new costs and revenue. You may decide to transfer the time from 
the Promotional project to the Regular project using a function in the Billing application. (Whereas 
in Sema4, if a project was set up as proposal, and then later became a project, you had to 
change it to Direct.) 

Labor Codes 

Unlike Sema4, Vision also lets you establish labor codes to classify the work that your employees 
do. Their use is entirely optional. For example, labor codes may be used to track the following: 

 The department associated with a labor charge 

 The project phase or segment associated with a labor charge 

 The service provided by the employee 
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 The staff level of the employee 

WBS Functionality 

WBS Phases and Tasks 

In Vision, the capabilities of WBS level 2 (Phase) and WBS level 3 (Task) differ from Sema4. 
Each phase and task in Vision acts as a sub-project. Phases and tasks can have different 
organizations, managers, overhead, revenue, and attributes, such as market segments. Often, 
Sema4, used tasks to distinguish project expenses, consultants, and labor for billing or project 
reports.  

Posting Labor and Expenses 

In Sema4, you could post labor and expense to any level of the WBS, whereas in Vision, you 
always make these postings to the lowest level of the WBS. 

When upgrading to Vision, discuss your use of phases and tasks in Sema4 with your Deltek 
Consultant to determine whether you can store some of this information at a higher or lower level 
in the WBS. Some firms track phase and task information in a lower level of the WBS; for 
example, the labor code and General Ledger account code are used for consultants or expenses.  

You do not need tasks in Vision to show project expenses on an invoice; the General Ledger 
account code allows for similar classification. 

Guidelines for Modifying the Sema4 WBS 

Consider the following general guidelines when evaluating a modification to your current Sema4 
Work Breakdown Structure: 

Consider eliminating WBS level 2 (Phase) and track phases in the labor code if the following 
conditions exist: 

 Phase names are consistent for all projects, such as preliminary design, design 
development, construction documents, and bid. 

 You can track expenses at the project level rather than the phase level. 

 You can track billings at the project level. 

 The project is performed by one organization or, if multiple organizations work on a 
project, revenue is shared via an inter-company revenue entry. 

 In general, you are using phases strictly to track labor costs 

Consider eliminating WBS level 3 (Task) and track tasks in the labor code if the following 
conditions exist: 

 Task names are consistent for all projects, such as study, report, planning, project 
management, and meetings. 

 You can track expenses at the phase level and not task level. For example, you can map 
tasks or categories to General Ledger accounts such as airfare, meals, lodging, 
structural, mechanical, electrical, or landscape consultant. 

 You can track billing at the phase level. 

 In general, you are using tasks strictly to track labor costs. 

If the above conditions for eliminating WBS 2 or WBS3 are not met, then you can maintain these 
levels in Vision. Additional information is stored at these levels in Vision including: 

 Principal, Project Manager, Supervisor 
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 Contract value (Compensation, Consultant Fee, Reimbursable Allowance) 

 Organization 

 Revenue accrual method 

 Overhead rate 

 All project info center tabs, including user defined fields 

Miscellaneous Differences 

 Vision does not contain an add-on-the-fly function. This feature in Sema4 exists due to 
the often detailed generic trees that are set up to handle labor and expense. Vision most 
commonly handles these through Labor Codes and the Chart of Accounts. 

 User defined fields in Sema4 are limited to a set amount of date, numeric and note fields. 
Vision’s robust user-defined fields allow for an unlimited number of tabs and fields. User 
defined fields in Vision can be date/time, numeric, character, note pad, lookups or drop-
down lists and links back to other Info Centers in Vision. User defined fields can be 
placed on any standard tab using the Info Center Designer.  

Account Breakdown Structure (ABS) 

The division of expense accounts in Chart of Accounts is fundamentally different between Sema4 
and Vision. These differences are explained below.  

ABS in Sema4 

Chart of Accounts  

In Sema4 the Chart of Accounts has two parts: the Balance Sheet accounts and the Income 
Statement accounts. Balance Sheet accounts are usually listed first, in the following order:  

 100s - Asset Accounts 

 200s - Liability Accounts 

 300s - Net Worth Accounts 

These are followed by:  

 400s - Income Accounts 

 500s and up - Expense Accounts. These accounts could be direct, payroll, marketing, 
overhead, and so on. 

At the expense level in Sema4, the user decides how to establish these accounts (for example, 
deciding whether an expense account is Direct, Indirect, or both). Also, users can use prefixes or 
suffixes in their accounts to define offices, departments, and so on. The suffixes and prefixes in 
Sema4 that represent offices and departments are handled in a separate field in Vision (called 
the Organization Code). This can simplify the Chart of Accounts as you do not need a separate 
account for each office or department for the same expense item.  

ABS in Vision 

Chart of Accounts  

In Vision, like Sema4 the Chart of Accounts has two parts: the Balance Sheet accounts and the 
Income Statement accounts. The definition of expense accounts in Vision is more detailed than 
that of expense accounts in Sema4. 
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Separating Expenses 

Vision separates expenses into four major categories: 

 Reimbursable 

 Direct 

 Indirect 

 Other 

Reimbursable Expense 

A reimbursable expense is an expense that is expected to be billed to the client, associated with 
a revenue-producing, regular type of project. An example of a reimbursable expense would be 
when your firm must hire an outside consultant to work on a project; you pay the consultant for 
services performed, and in turn, bill the client for the consultant's fees. Another example would be 
transportation or meal charges that are passed through on the invoice (The expenses are billed 
on a time and materials basis). 

The equivalent to a reimbursable expense in Sema4 is: 

1. Enter an expense through the Purchase Journal or Cash Disbursements. 

2. Select a Chart of Accounts ID.  

3. Select Type C -- consultants or R -- reimbursable.  

4. Choose the status R -- ready to bill. 

Direct Expense 

A direct expense is an expense that is not expected to be billed to the client. Direct expenses 
may be part of a negotiated fee or may be beyond the scope of the contract, and therefore not 
reimbursable. They are associated with a revenue-producing regular charge type project. 
Examples of direct expenses may be unexpected travel or phone charges, or charges a client 
specified as included in the fee. These are also known as Other Direct Charges (ODC). 

The equivalent to a direct expense in Sema4 is: 

1. Enter an expense through the Purchase Journal or Cash Disbursements. 

2. Select a Chart of Accounts ID.  

3. Select Type C -- consultant or R -- reimbursable, N -- nonreimbursable, and the status N 
for never bill. 

Indirect Expense 

An indirect expense is associated with a non revenue-producing project such as an Overhead or 
Promotional type project. These expenses are not directly associated with any one regular 
billable project, but are general costs of operation. Examples of Indirect expenses include 
electricity, office supplies, payroll benefits, and vacation time. 

Other Charges 

This category is used to enter non-project related expenses or revenue associated with below the 
line or non-operating activity, such as rental revenue or interest income.  
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Organizations 

Prefixes and Suffixes 

Sema4 adds prefixes and suffixes to account numbers to define offices, departments, or track 
other information. In Vision, organizational prefixes and suffixes are not used in this capacity. 
Therefore, if your company uses these, it is extremely important that you discuss this practice 
with a Deltek Consultant.  

Setting up Organizations 

Vision tracks the performance of offices, departments, and other profit centers by setting up 
organizations. Similar to separate businesses, you can view these organizations in terms of 
profitability, and you can specify how postings are made to them. For example, if your firm is 
divided into regions and offices, you may create a separate organization for each region and 
office, and maintain information for each of these distinct segments of your firm's business. Vision 
assigns organizations at each WBS level and in Employee Info Center; they are defined in the 
Chart of Accounts. 

Organizations are business units that incur expenses and/or generate revenue. 

Organization Reporting 

Organization Reporting is an optional Deltek Vision application that lets you monitor the 
profitability of discrete segments of your firm's business (for example, regions, offices, and 
departments). With Organization Reporting, you can print financial statements, project reports, 
and other reports broken out by profit center, by groups of profit centers, or consolidated for the 
entire firm. 

Organizations, which you define in Deltek Vision, may be considered individual business units 
within your firm, which generate revenue and/or expenses. In addition, the corporate office may 
also be set up as an organization, even if it does not generate profit by itself.   

During organization set up, you establish organizations and associate them with projects and 
employees. To keep track of an organization's revenue and expenses, you must establish in 
Vision which transactions, projects, and employees belong to which organizations. 

Job Cost 

The following table clarifies job cost terminology used in Sema4 versus Vision: 

Rate Sema4 Vision 

Pay Hourly Payrate Payrate setup if the Payroll module is enabled 
- this is only used in Payroll reports 

Cost Payrate burdened with overhead and 
direct personal expense 

Usually, hourly payrate used for project reports 
run at cost rate 

Bills Used in billing and reporting Used in Billing and for project reports run at 
billing rate 

Job Cost in Sema4 

The information needed to calculate job cost for each employee is recorded in Employee Setup. 
In Sema4, up to three rates are stored for cost, pay and billing rates, as shown in the following 
example.  
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This information is used to run Project Detail and Project Budget reports to obtain cost 
information on projects in Sema4.  

Job Cost in Vision 

In Vision, the term “job cost” can be used in the same way as “pay rate” in Sema4. For most 
firms, the job cost rate is either a standard hourly rate that approximates the pay rate, or a 
salaried rate that can be diluted into an hourly rate based on the number of regular hours charged 
in the period.  

Burdened Rates 

In Vision, users can report at burdened rates that are similar in concept to job cost in Sema4. 
Most firms who had burdened all employees the same in Sema4 will have the same overhead 
rate on all projects in Vision. Burdened rates are defined as the Vision job cost rate plus the 
overhead rate of the project.  

The burdened rate in Vision can vary project by project. If you choose to allocate a different 
overhead rate to different projects (perhaps a different rate for different Organizations), in Vision, 
the same employee has different burdened rates on these projects. 

Project reports in Vision are run by job cost rate, billing rate, or burdened rate. Unlike Sema4, 
overhead rates are calculated based on the project and cannot be calculated based on Employee 
setup 

The burdened rate in Vision is calculated as the employee’s cost rate times (100 + the project’s 
overhead rate) divided by 100. For Joanne Smith, with a cost rate of $19.2308 per hour, Vision 
uses a burdened rate of (19.2308 x 280 / 100) = 53.847 on project reports run at burdened rate. 

Overhead Allocation 

Overhead allocation is the practice of distributing indirect costs to revenue-producing projects. 
Once indirect costs are distributed, the revenue from projects supports the total cost of doing 
business.  

Overhead Allocation in Sema4 

The Direct Personnel Expense (DPE), overhead, and profit multipliers are applied to the payrate 
for various purposes in project costing and invoicing. The DPE and overhead multipliers can be 
used for invoicing if you choose (cost-plus invoicing), and are used in the calculation of fully 
loaded or burdened payroll costs for project management reports.   

The Overhead Multiplier is used to allocate overhead, burdened, or general and administrative 
expenses to projects. It is based on the ratio of overhead to labor costs and includes such 
expenses as rent, indirect (non-billable) labor, telephone, professional liability insurance, and 
utilities. While it varies from firm to firm, overhead is usually in the range of 150 percent to 200 
percent of Direct Salary Expense (DSE) (or 120 percent to 150 percent of DPE).  
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Overhead Allocation in Vision  

The Vision overhead allocation process distributes overhead to regular projects, phases, and 
tasks that direct labor or revenue is charged to during the accounting year. 

Overhead Allocation = Proration and Assignment 

Using Vision, you charge all indirect labor costs and indirect expenses to overhead and 
promotional projects and to indirect expense accounts. Vision then distributes these overhead 
costs to all regular projects, according to the allocation method you have chosen, either 
Assignment or Proration.  

Vision does not make an accounting entry for the reported allocation. Instead, the overhead 
distribution appears as a separate line item on project reports run at cost rates or in the Spent 
column on the Office Earnings report. 

Vision has two overhead allocation methods: Assignment and Proration. 

Assignment  

With the Assignment method, you supply a default overhead rate in Overhead Setup 
Configuration. This can be overridden at the project level in Project Info Center or by 
organization. Vision multiplies this rate by each regular charge type project's base (typically, total 
year-to-date direct labor or total year-to-date revenue) to yield the amount of overhead that is 
allocated to each project for the year. This computed amount can differ from the actual amount of 
overhead incurred. When you use the assigned overhead method, Vision allows you to override 
the firm wide rate (similar to the firm wide multiplier in the System File for Sema4) for individual 
project levels or by organization. To use a different overhead rate for a particular project level, 
enter the rate you want in Project Info Center on the Accounting Tab at the lowest level of Work 
Breakdown Structure. 

Vision uses the following formula to calculate the current year’s overhead for each project, where 
the rate is user-defined: 

Current year project overhead = project's year-to-date direct labor or revenue * assigned 
overhead percentage 

The Assignment method is the most common method, and is more effective for tracking a 
consistent overhead amount for regular projects. Also, it is easier for Project Managers to 
forecast overhead on projects. Although overhead is consistent, it is not a true number. A 
variance project is used to absorb the difference between actual overhead and assigned 
overhead. This number should be monitored, and if necessary, adjusted to achieve a more 
accurate year-end rate. The variance is calculated as the difference between actual overhead in 
all overhead and promotional projects and the assigned (budgeted) overhead allocated. 

Proration 

With the Proration method, Vision calculates the overhead rate by dividing the firm's indirect 
expenses by the firm's direct labor or revenue. (This also works at the organization level.) Vision 
then multiplies the resulting overhead rate by the base for each project to yield the amount of 
overhead to allocate. Because the actual amount of overhead is being distributed, typically there 
is no overhead variance associated with the Proration method. 

Vision uses the following formula to calculate the overhead for each project: 

Prorated year-to-date overhead % rate = (total year-to-date indirect expenses for firm or organization) / (total 
year-to-date direct labor or revenue for firm or organization) 

The prorated year-to-date overhead amount is then distributed to all regular-type projects using 
the following formula: 

(prorated year-to-date overhead % rate * year-to-date base) = current year’s overhead to project 
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This method is effective if you want to track an actual overhead number for each accounting 
period. It can fluctuate with the seasons, which makes forecasting for Project Managers more 
difficult. The effects of overhead can be viewed on the Overhead Allocation report, all project 
reports at cost rates, and in the Spent column of the Office Earnings report. 

Reports 

The following is an example of how overhead displays on Vision Project reports. This report is the 
equivalent of the Sema4 job cost report, with the Overhead separated from the individual labor 
amounts. 

Dates and Periods 

Sema4 

In Sema4, transaction posting and report generation are based on posting dates. Sema4 is a real 
time application where saved transactions flow through to all parts of the application. All Sema4 
transactions affect the General Ledger based on the Post Date entered. Financial statements and 
all other reports are run based on a selected date range.  

Vision 

In Vision, all processing is period-driven. A calendar of accounting periods is established, in 
which an accounting period typically represents a month. All financial statements and most other 
reports are based on the accounting period. The dates entered for transactions are used only for 
sorting and aging on some reports. Many detailed Project reports in Vision, such as the Project 
Detail report, can be run based on date ranges. 

Choosing a Period 

When you first log on to Vision you must choose a period in which to work. Instead of working 
with a date range, all information is entered and displayed by a specific account period. Vision 
can maintain as many open periods as desired. If a period is open, users can enter and post new 
transactions to that period. When a period is closed, information can only be viewed for that 
period. Opening and closing periods allows you to control where financial transactions display. 
Using the Vision Period Selection form, users may choose from a list of open periods, as follows.  

For example, if you put an entry in the period of June with a date of May 31, 2002, Vision posts 
the information in the June period and it is reflected on June financial statements. If you want to 
post something in the May period, then you need to change periods for that entry to affect the 
May financial statements.  

Date sensitivity is only recognized when running a detailed report for a project. It has no effect on 
the General Ledger. Accounting reports such as the Income Statement and Balance Sheet, are 
run by periods. 

Vision Periods and Processing 

Each time you process accounting transactions (for example, data entry transactions, Accounts 
Payable checks, journal entries, final bills), they are stamped with the fiscal period and year in 
which they were posted. This is how Vision keeps track of multiple periods and knows what 
information to report for which period. 

Each time you log on to Vision, you can choose the accounting period in which you want to work, 
either to process data or review information. As you work, you can easily change from one period 
to another. You can also set up Vision to default to the current period whenever you log on. Your 
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security settings determine whether you may open or close periods, and process or review 
information in prior or closed periods. 

Vision is a batch file system where all data is entered into a batch that must go through a posting 
process. When information is entered in Vision, a transaction file is created. The transaction file 
must be posted for the information to be saved in Vision. Posting permanently writes the 
information to the database. 

In Vision, the posting process is a permanent process. Unlike in Sema4, transactions previously 
posted cannot be directly edited because the posting generates an audit trail. To edit previously 
posted data, you must create reversing entries, review, and then post them. This generates a 
more accurate audit trail.  

Implicit and Explicit Postings 

As a general rule in accounting, all transactions must have a debit and a credit. There are some 
entries in Vision that only require one account to be input by the user. The other side of the 
transaction is pulled from configuration -- similar to the System File. 

 With explicit postings, you identify the account to post to when entering a transaction. For 
example, when you enter a purchase journal or accounts payable voucher, you identify 
the expense account to debit. 

 Vision makes implicit postings automatically, using default posting accounts that you set 
up when you install the software. The posting account used is based on the type of 
transaction posting. For example, when you install Vision you establish at least one 
automatic posting account for Accounts Receivable. When you post an invoice, Vision 
explicitly credits the revenue account that you specified, and implicitly debits the 
Accounts Receivable automatic posting account. 

In most cases, Vision posts one side of a General Ledger entry explicitly, and the other implicitly.  

Accounting Transactions 

The following is a list of the accounting transactions in Sema4 and Deltek Vision, including the 
abbreviations for the corresponding transaction codes. 

Sema4 Transaction Types Vision Transaction Types 

PJ – Purchase Journal AP – Accounts Payable Vouchers 

CD – Cash Disbursement CD – Cash Disburement 

PP – Payment Processing 

CR – Cash Receipt CR – Cash Receipts 

SJ – Sales Journal IN – Invoice Posting 

GJ – General Journal JE – Journal Entry 

AP Vouchers (AP) 

AP Vouchers are first vendor invoices, and are referred to as vouchers after they are entered into 
Vision. The equivalent of AP vouchers in Sema4 is the Purchase Journal. The Accounts Payable 
Voucher entry credits a liability account and debits a user-selected account. Liabilities that you 
enter are paid by check through Accounts Payable Payment Processing. When the liability is 
paid, Vision makes an entry to the cash journal and bank reconciliation. All Accounts Payable 
payments are recorded in the accounts payable module, and not through Cash Disbursements.  
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AP Disbursements (CV) 

AP Disbursements are used to make manual entries in Vision for hand-written checks or for one-
time entries. An AP Disbursement credits a cash account and debits a user-selected account. It 
also creates a voucher record in Accounts Payable and is recorded as a payment against the 
record. AP Disbursements affect Accounts Payable reports. This entry is also used to void checks 
that were entered in Sema4 prior to the conversion. Checks entered in Sema4 will not be 
available to be voided in Vision. 

Cash Disbursements (CD) 

Although this transaction has the same name as a Sema4 transaction, it functions differently. A 
Cash Disbursement in Vision records a credit to cash and a debit to a user-selected account. (It is 
similar to an AP Disbursements but does not affect Accounts Payable reports.) This entry is most 
typically used to enter petty cash, direct debits to your checking account, bank fees, and EFT, 
and to record hand-written checks. 

Cash Receipts (CR) 

Cash Receipts in Vision are very similar to cash receipts in Sema4. In Vision, Cash Receipts 
must be entered down to the same level of work breakdown (phase and task) as the billing 
invoice. The invoice will not clear off of the Accounts Receivable Aged report if the payment is 
posted to a different phase or task as the invoice. In Sema4, cash receipts are flagged based on 
the type of payment, such as F, F%, C or R. Vision’s cash receipt data entry does not have a type 
selection box. This is accomplished through separate A/R accounts that are mapped through 
Configuration. 

Invoices (IN)  

For every invoice you send to a client, you must run, edit, and post an invoice to an invoice file. 
You can create this invoice file in Invoice Transaction Center (for manual invoices), or Vision 
automatically creates this file if you use the Vision Billing application to create your invoices. If 
you do not own Vision Billing, you can create your invoices using a word processing program, 
and then enter and post the amounts to the invoice file.  

Journal Entries (JE) 

Journal entries are used to record depreciation, accounting accruals, salaries if you use an 
outside payroll service, and other miscellaneous transactions. Because Vision is a fully integrated 
system, you should not use journal entries to reclassify or adjust transactions that were previously 
entered through timesheets, accounts payable, or invoicing. Instead, you should make an entry 
that affects the Accounts Receivable account(s) and Accounts Payable account(s) through the 
same transaction form as the original entry.  

Timesheet corrections should be made through an adjusting timesheet, interactive billing, or a 
labor adjustment. Using a journal entry for these transactions creates a file reconciliation problem.  

One major difference between the Journal Entry in Vision and the General Journal in Sema4 is in 
the WBS Levels field. In Sema4, if you enter a General Journal to an expense account, it does 
not affect the project; in Vision it effects both the project side and the GL. 

Timesheets (TS) 

Timesheets are the basis for all labor costing and billing in Vision. For many firms, you enter 
timesheets at the same frequency as your payroll (that is, weekly, biweekly, semimonthly, or 
monthly). However, to receive accurate and up-to-date costing reports, consider entering 
timesheets more often, especially if employees are paid monthly. Timesheets posted in Vision 
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make an entry to the project subledger and the General Ledger, whereas in Sema4 they only 
affect Project Management reports. The timesheet posting either debits direct labor or indirect 
labor, based on the Project type. 

Miscellaneous Expense (MI) 

Miscellaneous expenses let you charge expenses to your projects that do not fit into one of the 
other transaction center types. Use this form primarily to distribute overhead costs to projects. 
Telephone, postage and shipping, models, photographs, and CAD are all expenses typically 
recorded as miscellaneous expenses. 

The Miscellaneous expense form is designed to charge previously costed overhead items such 
as telephone, postage and so on, to your regular projects. This process of reclassification allows 
you to reduce your overhead rate and show a more accurate picture of your projects' profitability. 
In addition, if you charge the project expenses to a reimbursable account, this process also lets 
you bill these items. 

Units (UN) 

Units are goods or services that are billed showing the quantity, rate, and amount. 

Units are used to bill expenses to projects, cost expenses to projects, or both. They are similar to 
expenses posted through cash disbursements, journal entries, or Accounts Payable vouchers 
because they can record expenses on projects and can be billed. They are different from these 
other data entry types in that units show both a quantity and a rate on the invoice. You can also 
use units to reclassify previously costed expenses from overhead to the project. 

Employee Expenses (EX) 

An Employee Expense is used whenever an employee files an Expense report, to record travel, 
automobile, and other expenses. Using Vision’s Expense Report module, you do not need to set 
up your employees as Vendors.  

Revenue Generation 

Work in Progress 

Sema4 

Firms generally use a Work In Progress (WIP) account in order to report revenue related to work 
completed, but not yet billed. The theory is that revenue is earned as the service is provided to 
the client, regardless of whether an invoice has been generated. The value of this unbilled 
revenue is shown in the Balance Sheet as an asset, labeled Work in Progress (WIP). The change 
in the value of the WIP asset causes an equal increase or decrease in the value of reported 
income for the accounting period.  

For instance, if WIP increases from $200,000 to $250,000, then unbilled revenue on the Income 
Statement will increase revenue by $50,000. If WIP decreases from $200,000 to $170,000, then 
unbilled revenue will reduce revenue by $30,000. 

In Sema4, the most common way to handle WIP is either through a manual General Journal 
Entry or using the Post Project Cost/Billing to GL Utility. 

Vision 

For an accurate view of a project's financial status, it is important to match revenue amounts with 
expense amounts. If you use Vision as an accrual-based system, you can recognize revenue as 
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you earn it and match revenue with expenses incurred to date. If you select (or create) the most 
appropriate revenue accrual method for each project, based on the underlying contract type, you 
can improve the accuracy of your reports and financial statements. This revenue appears in the 
job-to-date, year-to-date, and current sections of the Revenue column on the Office Earnings 
report. 

Because Vision integrates information between project reports and the General Ledger, the sum 
of all of your firm's projects’ year-to-date profit and loss equals firm-wide profit and loss. Thus, the 
financial progress of your firm can be determined through the appropriate use of revenue 
generation for each of your projects.  

Revenue generation allows you to: 

 Increase the accuracy of your financial statements. 

 Be less reliant on the Billing application to recognize revenue and thereby enhance the 
accuracy of your financial statements. Previously, you had to update your revenue figures 
once billing information was posted to the Sales Journal. This meant that you could not 
create financial statements until billing concluded. 

 Reflect revenue more accurately on Project reports. 

Vision recognizes revenue when you use revenue generation and post the resulting revenue 
generation journal entry file. The revenue generation file accrues revenue based on the revenue 
method that must be specified at the lowest level of Work Breakdown Structure (WBS) for each 
project in the Project Info Center.  

Revenue Methods 

Project Info Center provides you with six standard revenue methods that you can use to 
recognize revenue. You can also add dozens of your own user-defined revenue methods.  

The standard Vision revenue codes identify the following revenue accrual methods: 

Code Description 

B 

 

JTD Billings  

The job-to-date revenue method is the default in Vision. When you use this revenue method, 
Vision calculates job-to-date earned revenue as the total amount billed. This revenue method is 
appropriate for projects and tasks billed on a monthly basis if you post invoices in the same 
accounting period as you post expenses. 

M (JTD direct labor * multiplier) + JTD reimbursable expenses at cost rates 

This revenue method recognizes job-to-date earned revenue as job-to-date direct labor cost 
times a multiplier, plus job-to-date reimbursable expenses at cost rates. It is appropriate for 
projects billed on an hourly or percent complete basis.  

N No Revenue Generation 

This method specifies that you do not want to recognize revenue on any project level. Vision 
therefore does not generate revenue for the current period and you must recognize revenue by 
creating your own journal entry. 

P Percent Complete + JTD Reimbursable Expenses at Cost Rates 

Enter the percent complete in the Multiplier/ Amount field in the Project Info Center. If you do 
not enter a percent complete in this field, Vision automatically calculates the percent complete 
from labor and expense percent completes you entered. This percent complete is the overall 
percent complete that exists in the Project Budget Worksheet. 
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Code Description 

R Job-to-Date Receipts (Cash Basis Method) 

This method calculates job-to-date earned revenue as the total cash received. JTD Receipts is 
the only revenue method that is cash-based rather than accrual-based. This method is 
appropriate for jobs that have the highest risk of nonpayment. You might want to use this 
revenue method for speculative projects or tasks whose revenue is uncertain. 

W Job-to-Date Billings + Work in Progress (WIP) at Billing Rates 

This revenue method calculates revenue from job-to-date billings plus any project labor, 
consultants, supplemental billings, and expenses posted but not yet billed. This is the total 
billing amount that appears on the Unbilled Detail report. This amount excludes any amounts 
held or written off. 

Vision Billing 

This section covers the following Vision Billing Concepts: 

 Rate Tables 

 Billing Terms 

 Draft Billing 

 Interactive Billing 

 Refresh Billing Extensions 

The following explains each concept and, where applicable, highlights the similarities between the 
Vision Billing module and Sema4 Billing. 

Rate Tables 

Rate tables are unique tables that define rates for either labor or expense. You can set up tables 
that include special billing rates/markups for labor and expenses charged on a project. These 
tables can be project-specific or firm- specific. They are then associated with projects in billing 
terms and the correct rate/markup is applied to each employee/account with amounts charged to 
a project.  

 Labor Rate tables are similar to Sema4’s Billing Schedule that can be used to define 
unique labor rates for different projects or clients. Expense Rate Tables are similar to 
Sema4’s  

 Expense Rate tables define how certain expense’s are marked up and grouped on an 
invoice. 

Billing Terms 

Billing terms determine how you invoice a particular project. Through billing terms set up, you 
define how to bill fees, labor, expenses and consultants for each project. You must set up billing 
terms for each invoice you wish the system to generate. Along with general project and client 
information, you use billing terms to specify the method by which Vision calculates labor, 
expenses, consultant expenses, fees, retainers, retainage and upset limits on invoices. If your 
project has phases or tasks, you must also specify whether the tasks will have separate billing 
terms or use the terms specified at the higher level. Although billing terms are specifically unique 
to Vision, they contain aspects that are inherent to Sema4’s Billing Schedule, Category, and 
Invoice Design. 
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Batch Billing 

Batch Billing lets you print a group of draft or final bills at one time. Although it is usually desirable 
to print each bill individually, modifying and adding any necessary information before processing, 
sometimes you may find it more efficient to print bills in groups. For example: 

 You want a quick way to get draft bills ready for Project Managers to review. The quickest 
way is to print all of your draft bills at once, sorted by Project Manager. 

 You already reviewed and adjusted your draft invoices in Interactive Billing; now you just 
need to print and accept them. 

Often, your special billing forms tie up the printer when you print final bills. You can print bills 
quickly and free the printer for other uses. Invoices that are generated during Batch Billing are 
determined by entering selection criteria, such as all projects for a specific Project Manager. 
Batch Billing is similar to Sema4’s Pre Bill Worksheet.  

Interactive Billing 

Interactive Billing is designed to respond to the special challenges of the billing process. For most 
design firms, billing is not a mechanical process; billing requirements often vary from project to 
project and month to month. Most Billing Administrators approach invoices one at a time, 
ensuring that each invoice contains the appropriate charges and other information. This area of 
billing, completely unique to Vision, allows you to manipulate almost all aspects of an invoice in 
one central location. Instead of having to hunt down and edit one transaction at a time, Interactive 
Billing allows you to edit such things as the transaction’s Billing Status, and timesheet and 
expense notes. 

Refresh Billing Extensions 

Billing and cost rates for Project reporting is defined at the time of timesheet posting. Changes to 
these billing terms are updated by running the Refresh Project Billing Extensions utility. Run this 
utility when you change billing terms for a project for which you already posted charges. Refresh 
Billing Extensions is similar to the Update Rates Utility in Sema4, but differs because rates can be 
changed for a fiscal period and not by date range. 

WIP Reports 

Sema4’s Work-in-Progress report calculates billing amounts based on labor and expenses in the 
system. The billing rates for these transactions are stored at the time that the labor and expense 
is saved. The Work-in-Progress report in Vision is called the Unbilled Detail report. Unlike Sema4, 
the billing amounts in Vision are based on billing terms and not by a stored amount. At the time of 
conversion, billing terms must be set up for all projects in order for the WIP to tie out between 
Vision and Sema4. 
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Chapter 3: Migrating to Vision  

The Sema4 to Vision Data Migration tool guides you through the choices you need to make as 
you convert your data from Sema4 to Vision. The options you select will be stored automatically, 
so you may stop at any time and return to the mapping screens at a later time or date.   

The conversion process is broken down into twenty-seven mapping screens, each requiring a 
different task. These screens are listed below, in the order in which they display in the migration 
tool.  

1. Sema4 to Vision Data Migration Tool 

2. General Data Migration Settings  

3. Establish Vision Accounting Periods  

4. Establish Vision Timesheet Periods  

5. Converting the Chart of Accounts  

6. Account Mapping 

7. Breaking Vision Organizations Out of the Sema4 Account Structure  

8. Account Organization Review  

9. Sema4 Office/Department to Vision Organization Map  

10. Assign Organizations to Each Employee  

11. Vision Revenue and AR Accounts  

12. Credit Distribution and Retained Earnings Accounts  

13. Retainage  

14. A/P Vouchers  

15. Converting the Sema4 Work Breakdown Structure  

16. Assign Organizations to Work Breakdown Structure 

17. Establish Vision Labor Codes  

18. Establish Vision Labor Categories  

19. Converting Expenses   

20. Establish Vision Unit Table  

21. Converting Employee Information  

22. Miscellaneous Payroll Conversion Settings  

23. Conversion of Sema4 Withholding Codes  

24. Establishing Vision Withholding Codes  

25. Converting Invoice Designs to Vision Billing Terms  

26. Finishing the Conversion Process  

In addition to learning about each screen in the conversion process, we have also included a list 
of Conversion Considerations that you might find helpful. 
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Sema4 to Vision Data Migration Tool 

The Welcome screen is the first screen you see in the conversion tool. It provides an overview of 
the conversion process.   

The Welcome screen layout is similar to the other screens. An overview displays at the top of the 
screen and function buttons display at the bottom.  

Overview  

An overview displays at the top of each screen, outlining the purpose of the particular screen and 
providing a brief description of the data required.  

Buttons  

 

The following table describes the buttons that display at the bottom of each screen.  

Button Description 

Quick Step This drop-down list displays the names all of the conversion screens. 

You can move to a different conversion screen by highlighting the 
name. 

Help  Select this button to access the conversion tool online help.  

Close Select this button to end the conversion session. You can complete the 
process at your convenience. 

Back  This button returns you to the previous screen.  
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General Data Migration Settings 

 

Use the General Data Migration Settings dialog to select the conversion type and to select 
whether or not to convert the cash basis and payroll. Your choices here alter the rest of the data 
migration tool to suit your conversion needs.   

Conversion Types  

There are three conversion types: Basic, Standard, and Premium.  Each is explained, below.  

The Basic option converts the Sema4 setup tables, known in Vision as the Info Center. The data 
includes Projects, Phases, and Tasks (Vision Work Breakdown Structure or Labor Codes), Chart 
of Accounts, Clients, Vendors, and Employees. All transactions are ignored in this option.  

The Standard option converts both Info Center information and transactions such as accounts 
receivable, accounts payable, project expenses, project labor, and payroll records. It brings over 
the account balances as of the period-cut-off date in the following dialog as the GL opening 
balances. The balances are brought over from the Balances tab of COA setup. However, the GL 
detail is ignored.   

The Premium option converts both Info Center information and transactions. In addition to 
converting GL opening balances, it also brings over GL detail. Also, any departments or office 
distinctions indicated by a prefix or suffix in your chart of accounts can be transferred to Vision as 
organizations. 

Convert Cash Basis 

Selecting this check box converts the cash basis GL in addition to the accrual basis GL. 

Convert Payroll 

Selecting this check box converts the payroll tax table information. 
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Data Validation: Check Data 

The data validation process ensures that Sema4 data is compatible with the conversion process. 
Only those checks that require additional actions from you are displayed in this Check data 
screen. Note the following possible discrepancies that would need your attention:  

 Check 1099 Year – The 1099’s must be initialized in Sema4 before you run this 
conversion so that the current fiscal year is listed in Vendor Setup. 

 Check Duplicate Custom Field Labels – If two user-defined fields in the same area 
share identical names, one must be relabeled.  Relabel them in the System File Custom 
Fields tab. 

 Check Invalid Character in Custom Field Labels – If the utility finds duplicate ID 
numbers call tech support for assistance in removing them. 

 Check Invalid Vendor GL Account – If a chart of account number is referenced in the 
Sema4 system that no longer exists in your Chart of Accounts Setup, it must be re-added 
via chart of account setup. 

 Check Invalid Character in ID Fields (Apostrophy, Blank) – Any invalid characters 
found must be removed from the ID using the Change ID utility located under the Utilities 
menu in Sema4. 

 Check Invalid Employee ID Reference – If there is an employee ID in either the 
Principle or the Project Manager fields of Project Setup that no longer exists in the 
employee setup area, it should be changed to reference employee IDs currently in your 
system. 

Establish Vision Accounting Periods 

 

Generate a list of Vision accounting periods on The Establish Vision Accounting Periods dialog.  
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Quick Setup - Account Periods  

In order to assist in this process, fill out and run the Quick Setup- Accounting Periods fields. The 
actual fiscal years and periods that you create in Vision display in the corresponding grid.  

An explanation of each field on this form displays in the following table.  

Field Description 

Fiscal Year Start Date  
(MM/DD) 

Enter the start date month and day (year not necessary). 

Number of Periods in 
Fiscal Year 

Enter the number of fiscal periods using the drop-down list. You can 
select Monthly, Every Four Weeks, or Other.   

If you select Monthly or Every Four Weeks, the number of periods 
automatically display in the corresponding field. 

If you select Other, then you must enter a number in the 
corresponding field. 

Fiscal Year End Date 
(MM/DD) 

Enter the end date month and day (year not necessary). 

Current Accounting 
Period 

Displays the period based on the most recent transaction date. 

Close All Periods Except 
the Corresponding Open 
Periods in Sema4   

Select this option to generate only periods that correspond to 
periods currently open in Sema4. 

Period Cut-off Date The last date in the current period.  

Generate Periods  

Selecting the Generate Periods button enables the migration tool to create periods based on the 
information you supplied in the Quick Setup form. It scans the transactions and determines the 
first and last necessary periods to create. The last period in the grid will be set to Current 
Accounting Period in Vision.   

You may modify the information in the grid to fine-tune the structure of your years and periods. 
You can also open or close a period in the Status column. 

All entries in Sema4 dated beyond the period cut-off date are deleted by the Data Validation 
process prior to conversion. Vision does not allow for entries to future periods.  You must enter 
transactions such as accruals and depreciation during the fiscal period when they are incurred.  

Insert and Delete Buttons 

Use the Insert and Delete buttons to add rows or remove rows from the grid.  While Sema4 
allows the entry of records to dates in future periods, Vision does not allow any records to be 
entered into future periods and therefore all data in Sema4 dated after the period cut-off date is 
deleted prior to conversion.   
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Establish Vision Timesheet Periods 

 

Vision uses timesheet periods to control timesheet entry for all employees. While this does not 
affect converted data, it does affect your employees in Vision as they enter timesheets after the 
conversion is completed.  

Quick Step -Time Sheet Period  

The Quick Step – Time Sheet Period form assists you in creating several timesheet periods at 
once.  This is an optional step. You can establish Vision timesheets after the conversion is 
complete. Therefore, no periods are required in this screen.  

An explanation of each field on this form displays in the following table.  

Field Description 

Start Date 
(MM/DD/YYYY) 

Enter the timesheet start date: month, day and year. 

Frequency Use the drop-down list to determine timesheet frequency: 
Monthly, Semi-monthly, Bi-weekly or Weekly. 

End Date 
(MM/DD/YYYY) 

Enter the timesheet end date: month, day and year. 

Set Vision Periods 
with a Corresponding 
Open Period in Sema4 
to Open 

Select this option to ensure that Vision periods correspond 
with an open Sema4 period.   
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Generate Periods  

Select the Generate Periods button to create timesheet periods based on the data you supplied 
in the Quick Setup form.   

You may modify the information in the grid to fine-tune the structure of your years and periods. 
You can also open or close a period in the Status column.  

Insert and Delete Buttons  

Use the Insert and Delete buttons to add rows or remove rows from the grid. Delete All removes 
all rows from the grid. 

Account Mapping 

 

Change and modify the Sema4 account numbers for use in the conversion on the Account 
Mapping dialog. You may choose to do this to facilitate fitting certain accounts into certain 
locations in the Vision account structure. Alternatively, if you are converting organizations from 
your account structures, the options on this screen allow you to set up uniform account structures 
that can be parsed into Vision organization codes in a subsequent step.  

The steps you must take change depending on the Conversion Type you selected in General 
Conversion Settings.  

View/Change Accounts  

Select All Accounts or Accounts with. If you select the Accounts with  option, then use the 
corresponding drop-down list to determine those accounts. Clicking the View Accounts button 
populates the table with your selection. 
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Modify Accounts  

You may choose to modify accounts by adding/inserting or removing characters. You have two 
options:  

 Modify by Adding/Inserting - select an account, then select either To the End of the 
Account or At Position. If you select At Position, then fill in the position number in the 
corresponding field.   

 Modify by Removing - select an account, then select either From the Account, or At 
Position. If you select At Position, then fill in the position number in the corresponding 
field.   

 Modify Account Type – select an account or range of accounts with the View Account 
with option, then use the drop down menu associated with this field to select the account 
type you would like the account(s) designated. 

Execute Change on Displayed Accounts  

Select this button to perform the changes that you selected from the Modify Accounts section of 
this screen.  

Default Blank Interim Accounts  

Select this button to fill in or enter a default option in empty accounts.  

Default All Interim Accounts  

Select this button to fill in all accounts. It does not matter if they are empty.  

View Accounts  

Select this button to display the Sema4 Account Number, Description, and the corresponding 
Interim Account number of your All Accounts or Accounts with selection. 

Interim Account 

This field displays the uniform account structures that can be parsed into Vision organization 
codes in a subsequent step or the revised account number to be converted to Vision. 

Account Type  

This field displays the type of account being converted: asset, liability, net worth, revenue, 
reimbursable expense, reimbursable consultant expense, direct expense, direct consultant 
expense, indirect, or other. 
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Breaking Vision Organizations Out of the Sema4 Account 
Structure 

 

In this screen, you can map Vision Organizations from the Sema4 chart of accounts.  

Vision uses an Organizational model to establish accounting divisions. Vision also allows you 
create up to five levels of organization codes - these codes are then combined (one from each 
level) to create Vision Organization Codes. From this screen, you may name each code level. As 
you divide up your account, more levels display as necessary.  

Note that this screen only displays when the Premium Conversion Type option is selected in 
General Conversion Settings. 

In the example above, the chart of account number in Sema4 included a two digit suffix 
representing one organization level.  First, we indicate that the account number consists of the 
first four digits. Next, we provide the first and only organization level description of the office, and 
also indicate that it consists of the latter two digits. 

Vision Account at Structure  

Use the corresponding drop-down list to indicate the position of the GL number itself. Sample 
Acct:  

Use the corresponding drop-down list to enter an example of your conversion interim account 
number established in the prior dialog.  

Org Level: 

There will be as many Org Level fields as the number of organizations you select to break out of 
your account number. 
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From Position: 

This range defines the position and length of the various sections being broken out of your interim 
account numbers. 

Organization Delimiter  

Use this field to enter the organization delimiter. This is an optional field if you have more than 
one organization level.  For example, if you were establishing both offices and departments as 
separate organization levels, you might indicate that a decimal point separates the office code 
from the department code.  

Name Organizations 

Select the Name Organizations button after you have named each code level. From here, you 
can assign the Vision description for each organization code.  

Account Organization Review 

 

This step displays the results of data you entered in the previous steps.  

The grid displays all of the Vision Accounts to be created. It also displays the Interim Account 
that will be used when converting transactions.  

The grid displays the Organization that will be effected for each account when converting 
transactions. Finally, for each account, the Account Type must be designated. 

Note that this screen only displays when the Premium Conversion Type option is selected in 
General Conversions Settings. 
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Default Organizations  

Select this button to fill in organizations based on Interim Accounts. You must click this button at 
least once. 

Assign Missing Org. 

You can use this button to assign one organization to all those accounts that have a blank 
Organization field.   

Reset Org. 

Selecting this button reverts all organizations in the table back to their default values. 

Sema4 Office/Department to Vision Organization Map 

 

This step helps in the assignment of Vision Organizations to projects and employees. It is 
important to note that in later steps you can assign/reassign Organizations for specific employees 
and projects.  

Any project or employee with the values specified in the Office and Department fields below will 
receive the related organization. If the For Projects Default the Project Fee Account's 
Organization or For Employees Default the Technical Account's Organization check boxes are 
selected, then the organization of the account found on the Employee or Project Setup will 
supersede the organization mapped in the grid.    

You may use single field values when mapping. For example, if Office is BA and Department is 
clear, then any employees or projects with BA as an Office and no Department will receive the 
specified organizations.  

Note that this screen only displays when the Premium Conversion Type option is selected in 
General Conversion Settings. 
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For Projects Default the Project Fee Account's Organization  

When this option is selected, a project fee account's Organization is assigned on the lowest level 
of the project.  

For Employees Default the Technical Account's Organization  

When this option is selected, a technical account's Organization is assigned to the employees.  

Use Office Field to Aid in Organization Defaulting  

Select this option to include the Office code with each corresponding Organization. As there is 
no Office field in the Employee Setup screen, you can use the employee user-definable fields or 
any unused employee field as Office. Use the Employee's Office Field drop-down list to select 
a specific field to be treated as the Employee office.  

Use the Department Field to Aid in Organization Defaulting  

Select this option to link the Department code with each corresponding Organization.   

Generate List  

Select the Generate List button to display the list of organizations and the corresponding offices 
and departments (if selected, above).  

Insert and Delete Buttons  

Use the Insert and Delete buttons to add rows or remove rows from the grid.  

Assign Missing Org. 

You can use this button to assign one organization to all those accounts that have a clear 
Organization field.   

Reset Org. 

Select this button to revert all organizations in the table back to their default values. 
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Assign Organizations to Each Employee 

 

This step assists in the assignment/reassignment of Vision Organizations for specific employees. 
During the Default Organizations process, it uses the information from the prior step to aid in the 
population of an organization for each employee.   

This screen only displays when the Premium Conversion Type option is selected in General 
Conversion Settings.  

Default Organizations  

Select this button to produce a list of employees with their corresponding organization. Data used 
to fill this table is obtained from the information provided in the prior step – Sema4 
Office/Department to Vision Organization Map. 

Each organization listed in this table is editable.  

Assign Missing Org. 

You can use this button to assign one organization to all those accounts that have a clear 
Organization field.   

Reset Org. 

Select this button to revert all organizations in the table back to their default values. 
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Vision Revenue and A/R Accounts 

 

Vision's advanced revenue recognition capabilities enable it to recognize revenue based on a 
variety of factors. Generally, Vision utilizes two accounts to capture unrealized revenue (or work 
in process). The first is Uninvoiced Revenue; the second is Unbilled Services (Asset). These 
two accounts capture unrealized revenue company-wide.  

By default, Vision posts all Accounts Receivable to a single account. Alternately, Accounts 
Receivable can be routed to different accounts based on the revenue type that caused the A/R. 
This is helpful if you must display A/R by the Revenue Type.  

From this screen, you can establish account numbers for Uninvoiced Revenue, Unbilled 
Services, and Accts Receivable. These fields are used to set up Vision Configuration files. They 
do not impact any converted entries from Sema4.  

Uninvoiced Revenue  

Use the corresponding drop-down list to select an Uninvoiced Revenue account number. Your 
selection is used to set up Vision Configuration files, and will not impact any converted entries 
from Sema4. 

Unbilled Services  

Use the corresponding drop-down list to select an Unbilled Services account number. Your 
selection is used to set up Vision Configuration files, and will not impact any converted entries 
from Sema4.  

Accounts Receivable  

Use the corresponding drop-down list to select an Accounts Receivable number.  If there is a 
need to display A/R by the Revenue Type you will need to Adjust Cash Receipt A/R Accounts 
because Vision tracks these items by unique A/R accounts.  
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Accounts Receivable can be routed to different accounts. If you wish to use this option, check the 
Adjust Cash Receipt A/R Accounts check box to enter account numbers for the following 
accounts:  

 Fee A/R Account  

 Consultant A/R Account  

 Reimbursable A/R Account  

 Sales Tax A/R Account  

 Other A/R Account  

Credit Distribution and Retained Earnings Accounts 

 

Vision is designed to let you define the offsetting entry for each type of expense.  

For example, a user enters a time record for an employee named Bob Terrence. The employee's 
type determines debit account for this entry. The credit, however, is determined company-wide for 
Labor (Time Record, for example) transactions. The Credit Distribution accounts determine 
which credit account is affected for each of the transaction types described.  

Vision captures Retained Earnings in two separate accounts. The first is for the current year, 
and the second for all prior years. When a year is closed, the Current Retained Earnings account 
is closed into the Prior Years Retained Earnings account.  

This screen lets you determine account numbers for Credit Distribution and Retained Earnings.  
While your choices here do not affect the data converted from Sema4, it establishes the accounts 
in the Vision configuration for future posting. 

Credit Distribution  

From this section, you can enter account numbers for the following:  

 Labor Credit  

 Miscellaneous Expense Credit  
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 Reproductions Expense Credit  

 Consultant Accrual Expense Credit  

 Employee Expense Credit  

 Employee Advance Credit  

Retained Earnings  

From this section, you can enter account numbers for the following:  

 Current Years P&L  

 Prior Years Ret Earn  

The current year’s P & L account is typically a new account created for the purposes of facilitating 
the conversion.  By contrast, the Prior Year’s Ret Earn account is typically mapped to the Sema4 
Retained Earnings account.  The difference between the function of the two accounts is 
described on the previous page. 

Retainage 

 

Select from two options when converting Sema4 retainage to Vision.   

The first option is to convert retainage into the Fee A/R account. The advantage to this option is 
that it does not require Cash Receipts to be broken up. However, this option will not provide a 
separate column for retainage.  

The second option is to convert Sema4 retainage into a separate A/R account in Vision. This 
facilitates the display of retainage in the AR Ledger Report in its own column. This option carries 
the caveat that cash receipts must also be broken out separately.   

Selecting an Option  

Select To Vision Fee Invoices if you want to convert Sema4 Retainage to the Fee A/R account.  
Select To Vision Retainage Invoices to convert Sema4 Retainage into a separate Vision A/R 
account. If you select this option, you must enter an account number in the Default Retainage 
Account drop-down list.  
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A/P Vouchers 

 

From this screen, you can specify the cash account that is typically used to pay Accounts 
Payable. The account designated here will also be set as the default selecting account for 
Vision’s configurations. 

Converting the Sema4 Work Breakdown Structure 

 

 

From this screen, you can convert your Sema4 Projects, Phases and Tasks to the Vision Work 
Breakdown Structure (WBS).  
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Projects and Phases  

Sema4 Projects and Phases convert to Vision WBS1 and WBS2, respectively.  While the 
migration tool provides the option to eliminate the task level or WBS3, there is no such option for 
WBS2. 

Sema4 does not require a project ID on every single transaction in the system; for example, such 
overhead charges as office supplies could be entered without a project ID. Vision requires a 
project ID for every transaction. Because of this difference, the Sema4 to Vision conversion 
creates two new project IDs (WBS1 IDs) in Vision. WBS1 ID ZZZ is created as an overhead 
project and assigned to all accounting transactions posted to an indirect account with no project 
ID associated with it in Sema4. WBS1 ID Z99 is created as a direct project and assigned to all 
accounting transactions posted to a direct account with no project id associated with it in Sema4.  
Both projects are created with a Status of Dormant in Vision.   

In conversions where organizations are being created, a unique WBS2 is created for each 
organization found to have posted values for it.  For example, if account 7010.20 becomes 
account 7010 and organization 20 in Vision, and the conversion code finds posted amounts 
against that account with no project associated with it, WBS2 20 is created for WBS1 ZZZ during 
the conversion process.  This only occurs for those organizations that have postings against 
them.  The conversion code does not set up a WBS2 ID for every possible organization.  Such 
setup is a step you must process post conversion.   

Tasks  

If your company uses Tasks, then you may choose to either not convert them or to convert them 
to the third Vision WBS. You may also convert Tasks to a combination of Vision Labor Codes 
and/or Billing Expense Categories and Vision expense accounts. Tasks and Vision Labor Codes  

If Fee Tasks are converted to Labor Codes, then Tasks are available as an option on the 
Establish Vision Labor Codes conversion step.  

Convert Sema4 Task to Vision  

Select the Convert Sema4 Task to Vision check box if you wish to convert your Tasks. You 
have three Task options, listed below.  

 Task Marked as Fee to Vision WBS3 – This option retains the task as the third WBS level 
in Vision. 

 Task Marked as Expense to Vision WBS3 – This option also retains the task as the third 
WBS level in Vision. 

 Task Marked as Fee to Vision Labor Codes – This option eliminates fee tasks from the 
work breakdown structure and establishes them as labor codes in Vision. 

Note that if you choose to convert the Expense option, then you may select to convert a Fee 
option as well.  

Converting Expenses  

If Expense Tasks are used to map Expense accounts, then Tasks are available as an option on 
the Converting Expense Using Sema4 Tasks conversion step.  

If Sema4 Categories are used to map Expense accounts, then Categories are available as an 
option on the Converting Expense Using Sema4 Categories conversion step.  
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Determine Project Expenses Account  

You have three options for determining how you want to bring over Expenses based on Accounts. 
The option you select will affect the type of expenses you will establish at the Convert Expenses 
conversion step.  

You may choose one of the following three options:  

 Convert Expenses Using Expense Account from Sema4 Expense Task  

 Convert Expenses Using Expense Account from Sema4 Categories  

 Convert Expenses Using Default Vision Expense Accounts  

Renumber/Restructure Sema4 Projects, Phase and Task Buttons  

Select the respective Renumber/Restructure buttons to run the Global Change ID's utility for 
Projects, Phases, and/or Tasks. This utility allows you to view the existing data and remap your 
Projects, Phases, and/or Tasks directly in the conversion process. If you choose to renumber 
your IDs with this dialog, the renumbering will take place as part of the conversion after you send 
your data to Deltek. 

View Vision Work Breakdown Structure (WBS) 

 

After you select the WBS levels in the previous step, you must generate the WBS list. The 
options on this screen allow you to see the specific Work Breakdown Structure that is created at 
each level (in the grid).    

Note that if you selected the Premium Conversion Type option in General Conversion Settings, 
then the name of this screen displays as Assign Organizations to Work Breakdown Structure.  
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Vision Work Breakdown Structure for Level  

This drop-down list determines how many structure levels display when you populate an 
Organization for each WBS. You have three level options:  

 Level 1 - displays only Sub-Level  

 Level 2 - displays Phase and Sub-Level  

 Level 3 - displays Task, Phase, and Sub-Level  

Refresh WBS List  

You must run the Refresh WBS List in order to have an updated Vision WBS list.   

Run this list if you added a new project/phase/task in Sema4 since the last time you entered data 
in this screen, or made changes in the previous step. Default Org.  

Select this button to populate an Organization for each WBS. This form utilizes the information 
provided in the prior step. Each organization listed in this table is editable.  

The following table contains some of the common mapping that takes place in the Default WBS 
Organizations process. 

If the "For Projects, Default the Project Fee 
Account’s Organization" is selected, the 
organization for each of the following is based on: 

If the "For Projects, Default the Project Fee 
Account’s Organization" is not selected, the 
organization for each of the following is based 
on: 

WBS1 – Project – the organization as pulled off the 
account in the Fee/Cost field on the Accounts tab in 
Project Setup. If this account field is clear, the office 
and/or department of the Project Setup screen is 
used. 

WBS1 – Project – the office and/or department 
of the Project Setup screen is used to assign 
organization based on the “Sema4 
Office/Department to Vision Organization Map” 
step. 

WBS2 – Phase – the organization as pulled off the 
account in the Fee/Cost field on the Accounts tab in 
Project Setup. If this account field is clear, the 
organization of the parent project is used. 

WBS2 – Phase – the organization of the parent 
project is used. 

WBS3 – Task – the organization as pulled off the 
account in the Fee/Cost field on the Accounts tab in 
Project Setup. If this account field is clear, the 
organization of the parent is used. 

WBS3 – Task – the organization of the parent 
project is used. 
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Establish Vision Labor Codes 

 

In Vision, Project managers typically use labor codes to track the hours and dollars both spent 
and budgeted on a contract. Vision lets you establish a labor code structure that is configured for 
your firm. You may decide to have a simple one-level labor code representing activity. Or, you 
can create a more complex structure, up to a five-level labor code.  

You do not have to use labor codes. Without labor codes, your work breakdown structure may 
still contain enough information to meet your administrative needs for tracking work on a project.  
If you do not need labor codes you may choose the "Single Level" in the first level. In this case a 
Single Labor code (the Default Code) is created in Vision to allow the budget to convert.  

If you do decide to use labor codes, they are required with all timesheet transactions, to identify 
each hour of labor.  

Whatever you decide, you can create as many labor codes as you want. Since labor codes are 
firm-specific, no labor codes are pre-defined within Vision.  

Labor Code  

Use this form to determine the structure of your labor codes. The fields for this form are described 
in the following table. 

Field Description 

Labor Code 1), 2), and 3) You must tell Vision how many levels you plan to use and provide 
a label for each level (for example, department or staff level). The 
label displays as an identifier on some reports.   

Default Code Enter a default code for each labor code.   

Length Enter the length for each code. 
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Field Description 

Total Length This field automatically totals the length of your default codes. 
Labor Code combined length cannot exceed 14 characters. 

Labor Code Delimiter Enter the desired delimiter for your labor codes. The current 
delimiter for your labor codes displays for reference. A delimiter 
must be a special character, such as a period (.) or a comma (,); 
not 0 to 9, A to Z, or |. 

Generate Labor Code List Button  

After selecting your labor code levels, you need to click the Generate the Labor Code List 
button. This allows you to see the specific codes that will be created. These codes display on the 
accompanying grid.  

Use the Vision Labor Codes for Level drop-down list to view a specific level. 

Insert and Delete Buttons  

Use the Insert and Delete buttons to add rows or remove rows from the grid. 

Establish Vision Labor Categories 

 

In Vision, you can assign an employee to a labor category in order to facilitate processing time for 
reporting and billing labor by categories. These categories are used in Billing and Cost/Pay rate 
tables to associate billing and cost/pay rates based on the type of work an employee performs. If 
desired, Sema4 Staff Types can be converted to Vision Labor Categories. The Vision Category 
IDs must be numeric. While the data migration tool automatically generates numbers for any 
alphabetic staff IDs from Sema4, you can revise them to any number sequence of your choice. 
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The conversion process creates a master list of Vision Labor Categories and descriptions that 
contain each of the categories you define in this step. This list is the source of default category 
descriptions (which may subsequently be customized) when adding categories to Labor Category 
tables.  

Generate Labor Category List Button  

Select this option to generate the labor category list. As Vision Labor Category ID only accepts 
numerals, this step allows you to renumber the Vision Labor Category ID without having to use 
auto-assigned numbers.   

Insert and Delete Buttons  

Use the Insert and Delete buttons to add rows or remove rows from the grid. Delete All removes 
all rows from the grid. 

Converting Expenses 

 

Each converted expense transaction receives an account that is based on the Type and Status 
and, if selected in the prior screen, either Sema4 Category or Task,. Vision uses these accounts 
for dividing up expenses on Project Reports and Billing. Depending upon your choice on the 
Converting the Sema4 Work Breakdown Structure dialog, the button on the right of this dialog 
may read Generate Task List or Generate Category List.  If you chose to use only the default 
expense accounts, then only the top five fields would display and the remainder of the dialog 
would be blank. 

The account used for each expense is determined as follows:   

 If the expense type is R and the status R,H or B, the Reimb. Acct. is used.   

 If the expense type is C and the status R,H or B, the Reimb Cons. Acct. is used.  

 If the expense type is R or N and the status N, the Direct Acct. is used.  
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 If the expense type is C and the status N, the Direct Cons. Acct. is used.  

 If the expense type is N and the status N, the Indirect Acct. is used.  

If a task is not listed in the grid, the default accounts above the grid are used for its transactions. 
For example, if a project expense was posted only down to the phase level rather than to a task, 
the conversion tool uses one of the defaults based on the expense’s type and status. The option 
you selected to convert expenses in Work Breakdown Structure affects the display of this form.  

Default Vision Accounts for Sema4 Expenses  

Please enter account numbers for the following accounts:  

 RMB Account  

 RMB CNS Account  

 Direct Account  

 Direct CNS Account  

 Indirect Account  

Generate Task List  

Select this option to generate the task list. Your selections are reflected on the accompanying 
grid. If you selected the Convert Expenses Using Default Vision Expense Accounts option in 
Work Breakdown Structure, then the grid does not display and you need not generate a list.   

Insert and Delete Buttons  

Use the Insert and Delete buttons to add rows or remove rows from the grid. Delete All removes 
all rows from the grid. 

Establish Vision Unit Table 

 

Unit billing is Vision's method for billing/reclassifying indirect expenses. For example, your 
company receives an invoice for paper and books that is posted to an indirect account. If you 
choose to bill .05 for each copy and move the expense from the indirect account to the direct 
account, then you could use units.   
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This optional step lets you add Sema4 Expense tasks, Sema4 Categories, or both to the Unit 
Table. You can also edit the Unit Table to fine-tune the Units details.  

The conversion creates a single Unit Table (named “Default”) containing each of the categories 
listed in the grid. The Regular Account is the debit account when billing units on a billable project. 
The Overhead Account is the debit account when billing units on an overhead or indirect project. 
The Credit Account is the indirect expense account that contains the costs being redistributed.   

Default Vision Unit Accounts  

Please enter account numbers for the following accounts:  

 Regular Account  

 Overhead Account  

 Credit Account  

 Revenue Account  

Generate Unit from S4 Task  

Select this option to generate Units from Sema4 task. Your selections are reflected on the 
accompanying grid.  

Generate Unit from S4 Categories  

Select this option to generate Units from Sema4 Categories. Your selections are reflected on the 
accompanying grid.  

Insert and Delete Buttons  

Use the Insert and Delete buttons to add rows or remove rows from the grid. Delete All removes 
all rows from the grid. 
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Converting Employee Information 

 

This screen lets you establish parameters for converting your Employee data to Vision. 
Explanations of the screen’s fields follow.  

Vision Employee Types  

In this step, the conversion creates two Vision Employee types – Principal and Employee. 
These employee types control where labor expenses are posted.  

Select a Direct and Indirect account for both employee types. The Direct and Indirect Account 
fields also display on the Sema4 Employee Setup screen. The purpose in this step is to default in 
values for those employees that do not have the information already set up in Sema4.  

Hours Per Day  

The Hours Per Day setting is used when converting benefit accrual calculations. You have two 
options. The first option is to assign a Flat Quantity to all employees, and the second option is 
Calculated Based on Employee's Standard Hours Per Time Sheet; these options allows the 
conversion tool to calculate each employee's period hours based on their own standard hours per 
timesheet.  

If you select the Fixed Quantity option, enter the fixed quantity number in the corresponding 
field.  

Add Time Sheet/Expense Sheet Groups for Each Sema4 Department  

Vision establishes Time or Expense sheet groups to control the editing and viewing of time and 
expense sheets. If you select the Adding Time Sheet/Expense Sheet Groups for each Sema4 
department check box, then the conversion will add groups for each department and associate 
each employee with his or her group.  
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Convert Payroll Locales  

The conversion of Sema4 payroll locales to Vision Locales requires that a locale ID be assigned 
in Sema4. Locale would be filled out only if the withholding is locale specific in Vision (Type S-
State or L-Local). The locale ID will likely be the state's standard postal abbreviation if it is a state 
tax or N1 or N2 for NYC resident and non-resident taxes.  

This option is available only when the Sema4 Payroll Module is enabled.  

Convert Accrued Benefits  

Select this option to convert Sema4 accrued benefits data into Vision. This option is only 
available if you selected the Standard or Premium Conversion Type options in General 
Conversion Settings. 

Miscellaneous Payroll Conversion Settings 

 

Enter your last payroll check post date as well as regular and overtime pay period end dates and 
establish additional pay setups on the Miscellaneous Payroll Conversion Settings screen.  

Last Payroll Check Post Date  

Enter the last payroll check post date that appears in your payroll journal. This functions as the 
conversion cut-off date for your payroll journal transactions.  

Last Regular Pay Period End Date  

Enter the last regular period end date that was paid to your employees. This works in conjunction 
with the payroll check post date to allow the conversion tool to determine how much was paid, 
and how much remains to be paid in timesheets.  

Last Overtime Pay Period End Date  

Enter the last overtime period end date that was paid to your employees. This works in 
conjunction with the payroll check post date to allow the conversion tool to determine how much 
was paid, and how much remains to be paid in timesheets. 

Additional Pay Setup  

Like Sema4, Vision supports up to five additional Pay Setups. Because only one additional pay 
category is defined in this database, only one additional pay setup field displays in this step. More 
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fields display if you utilize more of the additional pays. These fields are used to establish Vision 
Payroll Additional Pay Configuration and do not impact any converted entries from Sema4.  

Conversion of Sema4 Withholding Codes 

 

Conversion of Sema4 Withholding Codes 

This screen is only visible if Sema4 Payroll is installed and the Convert Payroll check box is 
selected on the General Data Migration Settings dialog.  

Vision Withholding Codes are created for each distinct Vision code assigned to one or more 
Sema4 Withholding Codes. Consider the following examples:  

Sema4 has two deduction tables. One table is used for Bonus pay, and one table is used for 
Regular pay. Both tables contain the FICA Withholding Code. In the Sema4 Withholding Codes 
grid, each Withholding Code would likely be mapped to the same Vision Tax Code.  

Sema4 has two deduction tables. One table is used for Colorado employees and one table is 
used for Wyoming employees. Both tables contain a Withholding Code labeled “State”. In the 
Sema4 Withholding Codes grid, Colorado would likely be mapped to a "CO" Vision code, and 
Wyoming to a "WY" Vision code.  

Vision Withholding Codes exist at the system level. These codes may be assigned to each 
employee. If desired, each employee may override the Withholding Code’s calculation method, 
amount/rate, or limit.  

Generate Sema4 Withholding Code  

Select the Generate Sema4 Withholding Code button to map your conversion data in the 
accompanying grid.  The Vision codes may not contain spaces or special characters. If they do 
display in the Vision codes, they must be removed prior to conversion. 
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Establishing Vision Withholding Codes 

 

During the conversion, Vision creates a single Withholding Code for each code listed on the 
Vision Withholding Codes grid. These codes are system-wide, and are assigned to Sema4 
employees that use related Sema4 codes.   

If an Employee's Sema4 Withholding Code contained a different calculation method, amount/rate 
or limit, then these values are preserved on the Employee's Vision deduction code.  

Generate Vision Withholding Code  

Select the Generate Vision Withholding Code button to map your conversion data in the 
accompanying grid.  

While you should review all columns of the grid for accuracy after populating it, a few deductions 
require extra attention in regards to particular settings.  Specifically, all pretax deductions that are 
not a 401K must be re-designated as Type C in order for them to convert as pretax.  Also, all 
state deductions need to have the appropriate state abbreviation selected in the Locale field. 
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Converting Invoice Designs to Vision Billing Terms 

 

In this step of the conversion process, each Sema4 Invoice Design is matched to a Billing Term 
template. During conversion, each project is assigned the billing term that is related to its Invoice 
Design.    

You can assign Billing Tables (such as Rate and Category) in some of the fields below, even 
though you have not established these elsewhere. The conversion creates blank Billing Tables 
for each one you have named. After the conversion process, and before running your Billing 
processes, fill in these tables with their proper rates.    

Generate Invoice List  

Select the Generate Invoice List button to produce a list of Sema4 Invoice Design numbers. 
These numbers display in the Invoice Design field. The name associated with each number 
displays in the accompanying field when the number is selected.  

You may now begin to match each Invoice Design with a Billing Term using the following five 
tabs: General, Labor, Expenses/Consultants/Units, Fees, Misc, and Billing Backup.  

General Tab  

On the General tab, ten check box options display for Accounts Receivable and Billed-to-date 
figures that you can choose to have printed on your invoices. 

Labor Tab  

The following table describes all the fields on the Labor tab.  

Field  Description  

Labor Method  Select the labor method to determine how Vision extends labor charges on 
the invoice. There are five different labor methods.  
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Field  Description  

Overtime Method  Enter the method to use when extending overtime charges for labor 
charged to this project. There are three overtime methods.  

Multipliers  Enter the multiplier to apply to the labor billing amount. You can specify up 
to three multipliers.  

Ovt. Multipliers  Enter an overtime multiplier to use with employees who receive a premium 
rate on overtime hours, rather than a straight time rate.  

Rate Table  Enter or select the rate table that contains the employee rates to use when 
generating the invoice for this project. You must specify a rate table if you 
specified Rate Table, By Category, or By Labor Code as your labor 
method.  

Override Table  Select the labor override table to use (if any) when calculating labor on the 
invoice. The override table stores exceptions to the employee's rate in the 
selected rate.  

First Labor Sort  Select a First Labor Sort option to control the sort order and grouping of 
labor charges on an invoice.  

First Sort Table  Enter or select the rate table Vision will use to retrieve information, such as 
the rate established for the employee. You must select a table If you 
specify By Category or By Labor Code as the first labor sort method.  

Second Labor Sort  Select a Second Labor Sort option to control the sort order and grouping 
of labor charges on an invoice.  

Second Sort Table  Enter or select the rate table Vision will use to retrieve information, such as 
the rate established for the employee. You must select a table If you 
specify By Category or By Labor Code as the second labor sort method.  

Timesheet Detail Select to display timesheet detail, such as employee name, or omit the 
detail. If you do not show timesheet detail, Vision prints a summary of total 
labor. 

Show Rates Select this option to print the labor rate for each employee, category, or 
labor code on the invoice. Vision prints one line including the employee or 
category name, rate, and the extended amount for each 
employee/category. 

Show Multipliers Select this option to display the explicit multipliers (multiplier factors 2 and 
3) before the Total Labor line on the invoice. If you do not select this check 
box, Vision does not display the explicit multipliers. Instead, the amount is 
included implicitly in the Total Labor line.   

Flag Overrides Select this option to mark with an asterisk all employee names on the 
invoice whose billing rates are derived/determined from an override table. 

Show Ovt. Multiplier Select this option to display the standard or secondary overtime multiplier, 
the premium amount prior to markup, and the premium amount after 
markup before the Total Labor line on the invoice. 

Use as Project Reporting 
Default Terms Only 

Select this option to use the labor terms on reports only, and not for billing 
purposes. 
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Expenses/Consultants/Units  

The following table describes all the fields on the Expenses/Consultants/Units tab.  

Expense Fields  Description  

Method  Select the expense method to determine how Vision extends reimbursable expense 
charges on the invoice. There are four different expense methods. 

Multiplier Enter the multiplier to apply to expenses charged to this project. 

Table  
If you are billing expenses for this project (By Account, By Category, or By 
Vendor method), select the expense table to use. The expense table stores the 
multipliers for the accounts/vendors/categories that should be billed for this project.  

Show Detail  Select to display all reimbursable expense transaction detail (including transaction 
type, description, transaction date, vendor name, and so on). 

Show Multiplier 
Select this option to display the reimbursable expense multiplier on the project’s 
invoice. 

Use as Project 
Reporting Default 
Terms Only 

Select this option to use the Expense terms for project reporting and revenue 
generation purposes only. 

Consultants 
Fields 

Description 

Method Select the consultant expense method to determine how Vision extends consultant 
expense charges on the invoice. There are five different consultant expense 
methods. 

Multiplier 
Enter the multiplier to apply to consultant expenses charged to this project. 

Table  If you are billing consultant expenses for this project, (By Account, By Category,  
By Vendor, or Bill as Expense method) select the expense table to use. The 
consultant expense table stores the multipliers for the accounts/vendors that should 
be billed for this project.  

Show Detail  Select to display all consultant expense transaction detail (including transaction 
type, description, transaction date, vendor name, and so on).  

Show Multiplier  Select this option to display the consultant expense multiplier on the project's 
invoice.  

Use as Project 
Reporting Default 
Terms Only  

Select this option to use the Consultants terms for project reporting and revenue 
generation purposes only.  

 

 

 

 

Units Fields  Description  
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Method  The unit expense method determines how Vision extends unit expense charges on 
the invoice. There are two different unit expense methods.  

Multiplier  Enter a single multiplier to apply to the unit transactions. Vision applies this 
multiplier after the unit quantity is multiplied by the billing rate per unit.  

Show Detail  Select this option to determine the level of unit detail to display for each unit 
individually.  

Show Multiplier  Select this option to print the unit multiplier on the invoice.  

Use as Project 
Reporting Default 
Terms Only  

Select this option to use the Units terms for project reporting and revenue 
generation purposes only.  

Fees  

The following table describes all the fields on the Fee tab.  

Fees Fields  Description  

Fee Method  Select the fee method to determine how Vision extends fees on the invoice.   

Fee Basis  Select an option to determine how to calculate the fee for a project.  

Level  Select the level of Work Breakdown Structure: Project, Phase, or Task.  

Revenue Type Select the revenue type from the drop-down list. You can choose from six options. 

Type "F" converts 
to 

Select an option for Type "F". You may select Labor or Fee. 

Type "F%" 
converts to 

Select an option for Type "F%". You may select Labor or Fee.  

Misc 

The following table describes all the fields on the Misc tab.  

Misc Fields  Description  

Limit Method The upset limit method determines how Vision displays upset limits on the invoice. 
There are five different upset limit methods. 

Retainage If retainage is withheld, check this check box and then the revenue type(s) for which 
retainage is withheld. 

Invoice Override 
Accounts 

If you use accounts other than the defaults in conjunction with a particular type of 
charge on this invoice, note the accounts that should be used in their respective 
fields here. 

Print Invoices 
without Current 
Activity 

Select this check box if you want invoices to print even when there are no charges 
to invoice. 

Interest Type in the percentage of interest used on the invoice. 
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Misc Fields  Description  

Grace Period Type in the number of days before interest begins accruing. 

Invoice Footer 
If there is a message you want to display on the bottom of each page, type it in this 
field. 

Tax Code 1, 2, and 
3 

If particular taxes apply to this invoice, select them here. 

Billing Backup  

The following table describes all the fields on the Billing Backup tab.  

Billing Backup 
Fields  

Description  

Print Backup 
Report  

Selecting this check box will print a backup report in addition to the invoice itself.  
This check box works in conjunction with the twelve subsequent check boxes to 
determine what details are provided on the backup report. 

Include Labor for 
Select whether you wish to print backup for only labor sections or labor and fee 
sections of the invoice. 

Sort Labor  
Select one of the available sorting options for labor: date, labor, category, labor 
code or none. 

Sort Table When sorting labor by category or labor code, this field becomes available and you 
should select the preferred table you wish to sort by. 

Sort Exp/Con If printing expense or consulting backup, choose how you wish to sort them either 
by date, consultant, or none. 

Sort Table 
If sorting exp/con by consultant, this field becomes available and you should select 
the preffered table you wish to sort by.  
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Finishing the Conversion Process 

 

Review a summary of your conversion choices on this screen.  

Conversion Considerations 

Vision requires several business rules for data that Sema4 did not require. Data manipulation 
takes place on the Sema4 data in order to bring the data into Vision according to Vision’s 
business rules for data validation and relational integrity. You may need additional data setup or 
key conversions to adjust the delivered data to meet your specifications and needs.  

Consider the following information as you prepare for the conversion process:  

 Bank Reconciliation – The Vision bank reconciliation is populated with those checks 
booked to a cash account in Sema4, however they cannot be voided using the check 
void utility as they were not processed within Vision and therefore do not contain a 
unique Vision posting sequence.  Prior to conversion, review your checks for any that 
may require voiding and if possible do that before conversion. 

 Employee – An Inactive employee in Sema4 with no end date will be brought into Vision 
as Inactive, and that will count towards the user license. An Inactive employee in Sema4 
with an active end date will be brought into Vision as Dormant and that does not count 
towards the user license.  

 Employee – Last Name is a required field in Vision. Therefore, all Sema4 employee last 
name fields must be populated.  

 WBS, Vendor, Chart of Account – If the item is flagged as Inactive in the respective 
Sema4 setup screen, then the warning/lock setting in the System File setup will 
determine if the item is brought in to Vision as Inactive or Dormant. If the System File 
setup is set to Warning, the item will be brought in as Inactive; if the System File setup is 
set to Lock, the item will be brought in as Dormant.  

 Benefit Accruals - In Sema4, the indirect project screen has a check box indicating 
whether or not the project should accrue time. If that check box is selected, the project is 
set up in Vision as a Benefit Accrual and any associated accrual schedules are 
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converted. Consider reviewing all indirect projects and any associated schedules prior to 
conversion and cleaning up that data in case there are accrual schedules or benefit 
accruals you would prefer not to have converted over to Vision. 

 End-of-year Process - You must run the end-of-year accounting process for each fiscal 
year in Sema4 in order for the conversion process to run properly. This involves archiving 
the accounting information and posting retained earnings.  

 1099's - 1099’s must be initialized so the current fiscal year is listed on the top bucket in 
the Vendor Balances tab in Vendor Setup.  

 AP Liability Codes - Vision allows one to track accounts payable to various accounts 
much like accounts receivable. For example there may be AP Liability codes for AP 
Trade vs. AP Consultants, etc. Sema4 does not track AP data this way and as such does 
not transfer the data into such AP Liability codes.  

 The conversion creates a unique AP Liability code for each account and organization 
combination that it finds a cash disbursement posted against in the Sema4 data. You 
may wish to review these post delivery and use the Vision Key Conversion utility to 
change the AP Liability code ids and\or merge some together. 

 Special Characters - Vision does not allow the special characters of blank or apostrophe 
(single quote) in ID's (such as Vendor, Client, Project, and Employee). You should review 
all ID's in Sema4, on both active and inactive items, and use the Change ID utility to 
modify them accordingly.  

 Job Cost Rate - Vision does not have a job cost rate that correlates exactly to Sema4’s 
job cost rate, which is stored on every line of Sema4 timesheet detail. The employee’s 
pay rate will be transferred over as Vision’s job cost rate.  

 For Standard Conversions at Fiscal Year End – Since only account balances transfer 
in a standard conversion, if you intend to start processing in Vision at the beginning of a 
new fiscal year, follow the year end closing procedures in Sema4 prior to your final 
conversion. 

 Billing Rate Tables – Billing schedules are not converted to Vision. To simplify the setup 
of billing terms in Vision, review the Converting invoice designs to Vision billing terms 
dialog in the Data migration tool and indicate that a billing rate table is used on those 
invoices that have labor terms. One default billing rate table is created during the 
conversion which lists every employee and their current billing rate. 

 If you wish to set up multiple billing rate tables in a test database environment, it is 
possible to have those copied into any subsequent converted databases provided key ID 
fields such as employee, labor code, labor category, etc. have not changed between 
conversions. This is a post conversion request outside the scope of the conversion 
process and is billable on a T&M basis. This additional service must be requested prior to 
any subsequent conversions so appropriate time can be scheduled and the work may be 
quoted appropriately. 

 User Defined Fields – Review the user defined fields that convert to Vision on the S4 
tabs of the info centers.  If there are unnecessary user defined fields converting to Vision, 
you may prevent them from converting on the final conversion by eliminating the user 
defined field label from the System File in Sema4. 

 Work Breakdown Structure - If you set up additional WBS2 IDs to represent additional 
organizations post conversion on a test database, it may be possible for those new 
WBS2 IDs to be copied over to the live database provided no changes have been made 
in the organizational ids between conversions. This is a post conversion request outside 
the scope of the conversion process and is billable on a T&M basis. This additional 
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service must be requested prior to any subsequent conversions so appropriate time can 
be scheduled and the work may be quoted appropriately. 

 Organizations - The conversion creates organizations based on which settings in the 
data mapping utility are selected and the data currently existing in Sema4. For example, 
if the conversion results in a two level organizational structure, such as office and 
department, it only creates the combinations found in the Sema4 data. So while there 
may be 5 individual departments in the data, only the departments set up under an office 
ID are created. The conversion does not set up every possible combination of office and 
department. 

Only the IDs of organizations created during the conversion process are set up in the 
configuration tables.  Additional information required by the organization configuration in 
Vision must be populated post conversion. This required information includes the WBS IDs to 
be used for labor distribution, cross charge postings, and other information.  The conversion 
consultant will not populate these items for you. 

If you populate the additional organizational setup post conversion on a test database, it may 
be possible for that data to be copied over to the live database provided no changes have 
been made in the organizational IDs between conversions.  This is a post conversion request 
outside the scope of the conversion process and is billable on a T&M basis.  This additional 
service must be requested prior to any subsequent conversions so sufficient time can be 
scheduled and the work may be quoted appropriately. 

 Employee Types - Vision uses employee types in determining which general ledger 
accounts to use when posting direct and indirect time for each employee. You may have 
as many or as few as you wish.  The conversion uses the technical and administrative 
accounts found in the Sema4 Employee setup records in combination with the Sema4 
staff ID to create the Vision employee types.   

If the Sema4 staff ID associated with an employee is flagged as a principal, it results in one 
Vision employee type with a prefix of PRI followed by a numeral, one for each combination of 
technical and administrative accounts it finds in the Sema4 Employee setup. If the Sema4 
staff ID is not flagged as a principal, it results in a Vision employee type with a prefix of EMP 
followed by a numeral, one for each combination of technical and administrative accounts it 
finds in the Sema4 Employee setup.  You can use the Vision Key Convert utilities to change 
the employee type IDs post conversion. 

If no technical and\or administrative accounts are found in an employee’s Sema4 setup, then 
the default accounts specified in the data mapping utility are used to assign an employee 
type.  We recommend reviewing and cleaning up these settings in Sema4 prior to conversion 
in order to avoid creating unwanted Vision employee types.  

If you wish to assign Vision employee types based on another method, be it a custom field, a 
spreadsheet or some other business rule, this would be a post conversion request outside 
the scope of the conversion process and is billable on a T&M basis.  This additional service 
must be requested in advance so sufficient time can be scheduled and the work may be 
quoted appropriately. 

 Indirect Charges and Overhead Allocation – While indirect charges in Sema4 did not 
require assignment to an overhead project, Vision expects all indirect expenses to 
reference a project ID.  These indirect charges that convert from Sema4 without project 
IDs are not allocated appropriately if the prorate overhead allocation method is used in 
Vision. A history loading adjustment should be entered in the current fiscal year for the 
difference between the indirect expenses on project reports and the income statement. 

 Standard Payroll Deductions – The standard deductions of FICA, Federal and 
Medicare are driven by self-sufficient, standardized tax tables within Sema4.  It is 
unnecessary in Sema4 to manually supply these deductions with maximum limits in the 
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individual employee deduction tables.  If a maximum is typed into one of these fields in 
Sema4, the limit will convert over to Vision, but due to differences in functionality the limit 
will cause the deductions to inappropriately stop withholding in Vision.  Remove any and 
all manually inserted maximums for these standard deductions from Sema4 prior to 
conversion. 

 Vision Consultant Ledger – In many conversion cases, the consultant ledger will match 
the Accounts Payable Ledger.  However, if duplicate invoices numbers were entered into 
Sema4 for the same vendor ID, this will cause a discrepancy on the Vision Consultant 
ledger report. 

 Invoice Register – While typically invoices from Sema4 will appear appropriately on the 
invoice register in Vision, if the ‘Delete fully Paid AR Invoices’ utility was run in Sema4, 
those invoices which were deleted will not appear on the invoice register. 

 File Reconciliation report – Due to the necessity to shuffle expense accounts due to the 
five different Vision expense types in comparison to Sema4’s two, the YTD figures on the 
File Reconciliation report will not match upon conversion.  Once you open a new year in 
Vision, they should begin to match between the subledger and general ledger.  While the 
Accounts Receivable and Accounts Payable balances should match between the 
subledger and general ledger, this is only the case if those balances matched in Sema4 
prior to the conversion.  If a discrepancy existed within Sema4, it would also exist in 
Vision post-conversion. 
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Chapter 4: Preparing to Go Live on Vision 

When Deltek notifies you that your converted data is ready, complete the following steps: 

1. Check with the data consultant to determine where to retrieve the file containing your 
converted data, if the consultant did not specify.  

2. Restore the backup file to your Vision database. 

3. Contact Deltek Customer Care if you have any questions or problems retrieving or 
restoring the database. 

Load the Converted Data into Your Vision Database 

When you receive notification that the file containing your converted data is available, 
complete the following steps: 

1. Log on to the Customer Care Connect site. 

2. Click the My Stuff tab. 

3. Click My Files. 

4. The new file will be listed with a status of either Your file is ready to download or 
Support has your File Status. 

5. To download the file, click Your file is ready to download or Support has your File 
under Status. 

Restore the Converted Vision Database 

The exact steps for restoring the converted database depend on which version of SQL Server 
you are using. If you are not familiar with the procedure for your version, instructions are available 
in a knowledgebase article on the Deltek e-Support site. Do the following to view that article: 

1. Go to the Customer Care Connect site. 

2. Click the Answers tab. 

3. In Product, select Vision. 

4. In Search Text, enter 32919. 

5. In Search By, select Answer ID. 

6. Click Search. 

If you are using SQL Server 2000 for Deltek Vision, complete these steps to restore the 
converted data to your Vision database: 

1. Unzip the .bak file into the SQL Backup directory on your SQL Server (\Program 
Files\Microsoft SQL Server\MSSQL\Backup). 

2. Run SQL Server Enterprise Manager. 

3. Click + next to Microsoft SQL Servers to expand its sublevels. 

4. Expand SQL Server Groups and then expand your SQL Server. 

5. Right-click the Databases folder and click All Tasks and Restore database. You don’t 
need to change the data and log file names (the .mdf and .ldf files). Change only the 
path. Then click OK to restore the database. 



Chapter 4: Preparing to Go Live on Vision 

 

Migration Guide 68 

 

Notes on Restoring Converted Data 

 Restore the test conversion data as a new database. Don’t restore it over your Vision 
Demo database, for example. 

 Restore the final conversion data as a new database. Don’t restore it over your test 
database. That way, you have the test database available to refer to during the 
configuration process. 

 If you have more than one test conversion, you can restore the second set of test data 
over the first if you wish. 

 When you use the Weblink for Deltek Vision utility to enter configuration information for a 
new database and connect it to Vision, you can save time by copying the settings. Rather 
than clicking New, select  the Vision Demo database or another existing database in 
Current Database, click Copy, and enter the name of your new database in Database 
Name. 

Configure Vision 

Deltek Vision configuration is the process of specifying default settings that control and optimize 
how Vision will operate. Each Vision database has its own set of configuration settings. If, as 
recommended, you create new databases for both your test conversion data and your final 
conversion data, you must configure each of those databases. 

The conversion process will provide some configuration settings based on your Sema4 data, but 
most will initially be the Vision default settings. 

As part of the planning process, a Vision consultant will discuss the configuration options with you 
and help you determine the settings to best fit the needs of your firm. Later, as you are trying out 
the test conversion data, you can also try out different configuration settings. 

Before You Go Live on Vision 

Ideally, when you submit your current data for the final conversion, you know just how you want 
Vision configured. When you receive and load the final converted database, you enter those 
configuration settings in that database before you begin live operations with it.  

If your test database contains the configuration settings you want, use it as a reference tool as 
you duplicate the settings in your live database. In some cases, the Vision consultant may be 
able to copy some configuration settings from your test database to your live one. Check with the 
consultant beforehand if you want this done, so he or she can advise and assist you. Be aware 
also that this is a billable service. 

Initial Configuration Procedures 

The remaining topics in this chapter provide instructions for logging on to a Vision database the 
first time and descriptions of these initial configuration tasks: 

 Activating Vision modules 

 Setting up system security and employee access to Vision 

 Setting up server side email 

 Setting up the process server 
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Log on to Vision 

After you install Vision and connect to your database, you are ready to log on to Vision. 

1. Go to your firm’s designated Vision site. 

2. Either click the Deltek Vision link, or wait while the application is loaded. 

3. When the Deltek Vision login form opens, enter ADMIN in User ID.  

4. Leave Password blank. 

5. Use the Database drop-down list to select your database. 

6. Click Login. 

Activate Vision Modules 

When you log on to Deltek Vision for the first time, you must activate the modules you have 
purchased. The conversion process will activate some modules, but verify that all the modules 
you purchased are available in your Vision database. 

To activate Vision modules or confirm that they are already activated, do the following: 

1. Click Configuration » Module Activation on the Vision Main Menu to open the Module 
Activation dialog box. 

2. Enter the appropriate password in Password for each module you want to activate. 
When you enter a password, Vision automatically enters license information in License. 

3. Click OK. 

4. Click the Logoff icon in the upper-right corner of the Vision window to log out of Vision. 

5. Log back on to Vision. The appropriate modules should now be activated. 

Set Up Security 

Vision Security and the Conversion 

Your Deltek Sema4 user names and passwords are not converted to Deltek Vision. When you 
install Vision, the following security information is set up automatically in the database so you can 
log on to Vision: 

 One user ID: ADMIN (with no password) 

 One role: Default 

Set Up Employee Roles 

Before your employees begin using Vision, you must set up roles for each of them in Vision. You 
can then use these roles to define each employee’s security access to the various Vision 
applications and forms, and to set each employee’s access to lookup and reporting options. You 
can also set up passwords, if desired. 

For detailed information on setting up security for Vision, refer to the Deltek Vision 
Implementation Guide or to the Vision help system. 
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Copy Security from the Test Database to the Live Database 

After you set up security in your test conversion database, you may choose to have the security 
information copied to your live database when the final conversion is done. Before you load your 
live Vision database, ensure that a copy of your test security setup is saved. Notify your Vision 
consultants if you want this done, so they can advise and assist you. 

Set Up Server Side Email 

You can use Deltek Vision’s email functionality to send reports to principals, project managers, 
and other interested personnel at your firm. Before you can use Vision’s internal email features, 
you must configure your server side email information. 

To configure server side email, do the following: 

1. Click Configuration » General » System Settings on the Vision Main Menu to open the 
General System Setup form. 

2. Click the Email tab. 

3. Enter information in the fields on this tab, as described in the following table, and click 
Save to save your entries. 

Field Description 

Email Server Enter the name of the email server. 

Port Enter the server port number to use for email. 

Default Sender Enter the email address for the default sender of system-wide 
email. 

Default Help Desk Enter the email address for your centralized Help Desk 
mailbox. You can choose to send email directly to Deltek, or 
you can set up an internal mailbox to receive and respond to 
questions from your staff. 

Username (optional) Enter a username, if applicable. 

Password (optional) Enter a password, if applicable. 

Email Server Enter the name of the email server. 

Set Up the Process Server 

The Vision Process Server enables you to submit jobs to a process queue and schedule them for 
processing. Deltek Vision users can submit reports, transaction postings, batch billings, and other 
Vision processes to a process queue in order to keep their workstation free for other jobs. Before 
you can begin using process queues in Vision, you must set up your process server options. 

To set up process server options, do the following: 

1. Click Configuration » General » System Settings on the Vision Main Menu to open the 
General System Setup form. 

2. Click the Servers tab. 
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3. Enter data in the fields on this tab, as described in the following table. To add a blank row 
to a grid, click the Insert grid option. To delete a row from a grid, select the row and click 
the Delete grid option. Click Save when you are finished.  

Field Control Description 

Retain job history for x 
days 

Select this option if you want Vision to save history for completed 
processes in the queue. The default for this field is to retain 
process history. 

If you are not retaining process history, Vision deletes process 
entries from the queue after they have completed running, have 
failed, or have been cancelled. If the process entry has an alert 
pending, Vision deletes the process entry after the submitter has 
been notified. 

If you are retaining process history, Vision deletes process entries 
from the queue after the specified number of days. If the job has an 
alert pending, Vision deletes the process entry after the specified 
number of days and only after the submitter has been notified. 

Retain Errors for x days This option allows you to set a limit on the number of days that the 
server retains error reports for successful runs. If you enter an error 
retention period of 0 days, Vision saves all error reports indefinitely. 

Retain report output for x 
hours 

This option allows you to set a limit on the number of hours each 
generated report is saved on the server. By default, each report is 
saved for 24 hours. 

Enable report usage 
logging 

Select this option to enable report logging. Vision will log every 
report request (generate, print, email, view) in the event viewer. 

Process Queues:  Name Required. Enter a name by which to identify this process queue. 
The queue name should be descriptive. This name displays 
wherever process queue information displays and may be 
selected. 

Process Queues:  
Dedicated Server 

If you want to dedicate a queue to a specific server, select the 
server from the drop-down list. Only that process server will run 
jobs on that queue. This is useful if you want a particular machine 
to run jobs of a particular enter. For example, you may want all 
large jobs to run on the most powerful machine. 

Process Queues:  Max Enter the maximum number of jobs to run concurrently in this 
queue, regardless of how many jobs are actually in the queue. 
Enter zero for no limit. 

Process Queues:  Priority Enter the priority for the process queue. Zero (0) is the highest 
priority. The priority level you enter is used to determine user 
access (by role) to the process queue. 

Process Queues:  Status Displays the status of the queue, either Running or Stopped. 
Status is determined by whether you click the Pause or Continue 
grid option. 

Actuate Report Servers:  
Server Name 

Enter a report server name. These servers are used to generate 
reports. 

Application Servers:  
Server Name 

Enter an application server name. These servers are used to run 
application processes, such as transaction posting. 
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Balancing Vision to Sema4 

Following both the test conversion and final conversion of your Deltek Sema4 data to Deltek 
Vision, the data consultant that performs the conversions prints and compares sets of reports 
from each system to confirm that your systems balance.  

If you want to repeat the confirmation process yourself when you receive your converted and 
tested data from Deltek, this document provides instructions for printing and reviewing the key 
Sema4 and Vision reports. The values that we compare between the two systems are AP open 
items, AR open items, trial balance closing balances, project cost and billed amounts, and 
unbilled hours and dollar amounts. 

Sema4 Reports 

All of the Sema4 reports you need, with the exception of the Project Summary report, can be 
printed using the standard report dialogs and FRXs. The Project Summary report requires 
alterations before use in this process. 

 AP Open Items 

 AR Aging 

 GL Trial Balance 

 Customized Project Summary report 

It is important that you print these reports at the time that you create the backup copy of your 
Sema4 data to submit for conversion. You need to print them from the exact set of data that you 
submit for conversion. If processing continues in Sema4 and you print the reports at a later time, 
you won’t be able to confirm that the two systems balance. 

The last figures to tie out from Sema4 rely on a select command run within the command window 
and not a report. This command is provided in a later section. 

General Ledger Data 

In Sema4 

In Deltek Sema4, print the GL Trial Balance report for all accounts through the last accounting 
period converted using Current and Archived Data. 

In Vision 

Print the General Ledger Trial Balance report in Deltek Vision for Year-to-Date and clear 
Account Subtotal. (Click Reporting » General Ledger on the Vision Main Menu.) If you are 
using organizations in Vision, you also need to check the Organizations check box on the 
Sorting/Grouping tab. 
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To Balance 

If the beginning balance and ending balance totals are 0.00 in the Vision Trial Balance report, the 
systems should balance. As additional confirmation, compare closing balances from the Vision 
report to the balances printed on the Sema4 report.  

Accounts Receivable Data 

In Sema4  

In Deltek Sema4, print the AR Aging report through the last accounting period converted. Select 
Summarized, Open Items Only, Include Advanced Payments, and Order by Project.  Also 
verify that all ranges are set to blank for the first field and ZZZ for the last field to capture all 
possible entries.  The one exception to this range setting is the AR account range.  Select the AR 
account range from the drop down lists starting with the very first option in the list and ending with 
the last account option from the drop down list. 

In Vision 

1. In Vision, print the AR Aged report through the last accounting period converted (click 
Reporting » Accounts Receivable on the Vision Main Menu). 

2. On the General tab in the Options for AR Aged dialog, select Period End Date and for a 
more concise report, use the Phase Base Rollup and Task Base Rollup to summarize at 
the project level. 
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3. On the Options tab, select the Print all Invoices with Retainage, Age Unassigned 
Receipts, and Print Retainer’s Balance check boxes.  Clear the Age Interest check 
box.  For a more concise report, clear the Print Invoice Detail box.   

 

4. If you have very large balances, you can adjust the width of your Balance Column on the 
column tab to 1.00 inches rather than the default 0.70 

To Balance 

The Inv Amount Grand total on the Sema4 report should match the Final Totals Balance on the 
Vision report. 
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Accounts Payable Data 

In Sema4 

In Deltek Sema4, print the report ordered by Vendor ID with an As of Date of the last day of the 
last period converted to Vision. Verify that your ranges are blank for the first field and ZZZ for the 
last field to capture all possible entries.  From the options and check boxes on the left hand side, 
select Summarized, Open Items Only, and select the Consultant, Employee, and Vendor 
check boxes. 

In Vision 

In Deltek Vision, print the Voucher Ledger report after changing the Format to Vendor Summary 
and the Include to Unpaid. (Click Reporting » Vendor on the Vision Main Menu.)  

 

To Balance 

To confirm that the two systems balance, compare the Inv Amount Grand total from the Sema4 
report to the Balance Final Total on the Vision report. 

Project Cost Data 

In Sema4 

To compare Project cost data between Sema4 to Vision, you must modify one of Sema4’s 
standard reports. Before running the report, you must also run the Update Project Default 
Multipliers utility from the Utilities menu. Consider running this utility and the customized project 
report on a copy of your data rather than your live Sema4 data if you use these multipliers 
regularly for project reporting purposes. Instructions for the modification process for the report 
follow and you must complete each step in progression. 

1. From the Sema4 Proj Mgmt menu, select Project Management Report Design.   

2. Click Ok through the warning.  

3. In the Finder field, enter P07.  

4. Once P07:A displays on the screen, click the Copy icon from the toolbar. 

5. Enter a Target ID of VI7.  If this ID is already used for another custom report, choose a 
different ID.  
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6. Click Ok. A small complete message should display in the upper right hand corner of the 
screen.  

7. Unless an error displays instead, click Exit.  

8. In the Finder field, enter VI7.  

9. Click the Columns 1- 6 tab.  

10. Click Edit.   

11. Right click in the Definition area of column 5, the A/R column.  Select Delete Column.  

12. When the second dialog displays, confirm that it is going to delete column 5 and click Ok.  

Hours Spent now becomes column 5.   

13. Right-click on column 5 again and select Delete Column.  Verify the column number to 
be deleted and click Ok. 

 

14. Click on the Columns 7 – 12 tab.   

15. Right click in the Definition field of column 9, Total Cost, and select Delete Column.   

16. Verify the column to be deleted and click Ok. 

17. Click on the Columns 13 – 18 tab.  

18. Right click in the Definition field of column 14 and select Delete Column. 

19. Verify the column to be deleted and click Ok.  

20. Again, right click in the Definition field of column 14 and select Delete Column.   

21. Verify the column to be deleted and click Ok.   

22. Right click in the Definition field of column 18 and select Delete Column.   

23. Verify the column to be deleted and click Ok. 
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24. Click Save.  

25. Add VI7 to your Custom PM Report menu under the Proj Mgmt menu.   

26. From the Utilities menu, select the Update Project Default Multipliers option.  To run 
this utility, choose only Active and Direct projects. Set all the ranges to blank through 
ZZZ and for the latter Project Start Dates range field, enter in the last day of the current 
period. Select both DPE and Overhead check boxes and set both corresponding fields to 
1.0000. Click Ok. 

 

27. After this utility completes, you are ready to run your custom Project Summary report.  
From your Custom PM Report menu, select VI7.  Eliminate the Start Date and enter the 
last day of the current period as the End Date. All ranges should be set to blank through 
ZZZ.  Select Do Not Check for activity. 
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28. On the Additional Options tab of the custom report, only select Active and Direct 
Projects.  Make sure that you also select Report Grand Total. 

In Vision 

In Deltek Vision, print the Office Earnings report. (Click Reporting » Project on the Vision 
Main Menu.) 

1. Under Options on the General tab of the Options for Office Earnings dialog box, select 
Cost in Report at, and check Print Final Totals. Clear the Print Overhead check box 
and for a more concise report rollup both phases and tasks. 

 

2. On the Activity tab of the options dialog box, clear all check boxes under Activity Basis. 
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3. On the Columns tab, clear Unbilled Amount, A/R Amount, Spent Amount, Profit/Variance 
and Profit/Variance Percent check boxes.  Select the Labor Amount, Total 
Consultant, and Total Other Expenses. 

 

4. Open the Selections Project Look up dialog. Select the Active Only check box in the 
lower left corner and in the Advanced Searching table, choose a Search Enter of 
Charge Enter, and Operator of equals and enter a Search List value of Regular.  

5. Add an additional line in the Advanced Searching table that states Project Number not 
equal Z99. Z99 is a generic project used by the conversion process for those entries that 
do not correctly identify with an existing project. 
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To Balance 

To confirm that the two systems balance, check the following: 

 The Final Totals JTD Billed figure and Revenue figure on the Vision Office Earnings 
report should match the Sema4 modified Project Summary report Grand total PTD Billed 
figure. 

 The Final Total JTD Received amount on the Office Earnings report should match the 
modified Project Summary report Grand Total PTD Received figure. 

 The Final Total JTD Labor Amount on the Office Earnings report should match the 
modified Project Summary report Grand Total PTD Payroll*DPE*Overhead amount. 

 The Final Total JTD Total Consultant on the Office Earnings report should match the 
modified Project Summary report Grad Total PTD Consultant Cost. 

 The Final Total JTD Total Other Expenses on the Office Earnings report should match 
the sum of the Grand Total PTD Reimb Cost and Nonrm Cost. 

If some of the total figures on the modified Project Summary report display as asterisks, return to 
the project management design screen for report ID VI7 and enter additional pound symbols (#) 
in the Format field of the column in which the asterisks display.   

If you notice discrepancies in the two reports, they most commonly occur in the Received and AR 
columns.  This results from the different methods used by the two systems to calculate these 
figures.  In Sema4, for example, anything posted in a cash receipt is included in the Received 
figures, but in Vision, the cash receipt must reference the AR account to be included in the 
Received figure.   
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Verify WIP Numbers 

To verify the unbilled dollars and hours recorded against projects between Sema4 and Vision, 
you must run the following select and sum commands in the command window of Sema4 and 
then compare them to the Unbilled Summary report in Vision described in the following section. 

In Sema4 

From the Sema4 menu, select Utilities » Command Window. Click Ok through the warning and 
then enter the following select statement in the command window: 

Select timbhrs*timprate as cost, timbhrs as hours from time where timstatus=’R’ and timproj in (select proidno 
from project where prostatus=’A’ and prodirect=.T. and proposal=.F.) 

This should all display as one long line in the command window. Press the Enter key, and a table 
will display with hours and dollars figures. Exit out of this table and your cursor should display on 
the second blank line of the command window. Enter the following: 

Sum(cost) 

After pressing Enter again, the dollar total for all ready-to-bill hours should display on the upper 
left hand side of the Sema4 screen. Next, enter: 

Sum(hours) 

After you press Enter again, the total ready-to-bill hours should display underneath the dollar 
amount. You can either jot these numbers down for reference later, or as long as you do not exit 
out of Sema4, they will remain in the upper left corner. 

To obtain the totals for the hours and dollars on Hold, edit the first line in the command window by 
changing the verbiage timstatus=’R’ to read timstatus=’H’. Place your cursor at the end of this 
command before pressing the Enter key again.  After the table opens, again close out of the table 
and press Enter twice more and the subtotals for the held hours and dollars will also display on 
the left hand side of the Sema4 screen underneath the totals for the ready-to-bill hours. 
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A similar select statement is used to sum the unbilled consultant and expense charges. 

Select jobcost*jobqty as cost from jobexp where jobstatus=’R’ and jobenter=’R’ and jobproj in (select proidno 
from project where prostatus=’A’ and prodirect=.T. and proposal=.F.) 

After pressing Enter, again close out of the resulting table and enter: 

Sum(cost) 

Press Enter again and the total dollars for the reimbursables with a status of ready to bill displays 
in the upper left corner.  Once this number is displayed in the upper left corner, return your cursor 
to the select jobcost line and change the jobstatus=’R’ to jobstatus=’H’. 

To obtain the consultant dollar figures, change the jobenter=’R’ to jobenter=’C’ and repeat the 
same process for summing of the cost for both status R and status H. 

In Vision 

1. In Deltek Vision, go to Configuration » Billing » Reporting Default Terms, set the 
Labor Method to Rate Table on the Labor tab, and set both Expense Terms and 
Consultant Terms to By Account on the Exp/Con/Unit Tab. Save these changes. Now 
you are ready to print the Unbilled Summary report.  

2. Click Reporting » Project on the Vision Main Menu. 

3. On the Options dialog, click the Options tab and select Use Reporting Default Terms 
and Show Final Totals.  Switch the Report Basis option to At Cost.  Because we are 
only comparing Billable and Held transactions, you can clear Transactions to be Written 
off for a shorter report. 

 

4. Open the Selections Project Look up dialog. Select the Active Only box in the lower left 
corner and in the Advanced Searching table, select a Search Enter of Charge Enter, 
and Operator of equals and enter in a Search List value of Regular.  Add an additional 
line in the Advanced Searching table that states Project number not equal Z99. Z99 is 
a generic project used by the conversion process for those entries that do not correctly 
identify with an existing project. 
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To Balance 

The numbers summed by the selection commands in the command window of Sema4 should 
match the Final totals for Billable and Held Hours, Labor, Consultant, and Expenses on the 
Unbilled Summary report. 

Verify Info Center Data 

After the conversion utility is run, Deltek recommends that you verify the data in your Deltek 
Vision Info Centers to ensure that records were converted properly. Check several records in 
each Info Center, reviewing record contents directly in the Vision form. Verify that the data is 
accurate and complete. When your Deltek Sema4 database is converted to Vision, many data 
items that did not have an equivalent in Vision are added to an S4 tab in Vision. For example, any 
user defined fields established in the System File of Sema4 can be found on the S4 tab. These 
are custom tabs created by the conversion process. You can change the tab names and the 
names of the fields on the tabs. 

The following table lists the Setup dialog in Sema4 and the corresponding Info Center in Vision. 

Sema4 Setup Vision Info Center 

Project/Phase/Task Setup Project Info Center 

Client Setup Clients Info Center 

Vendor Setup Vendors Info Center 

Employee Setup Employees Info Center 

Chart of Accounts Setup Accounts. Chart of Accounts Info Center 

Contact fields from various Setups Contacts Info Center 
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Perform Segment Testing 

After you have verified that the conversion of data was successful, you are ready to begin 
segment testing—one of the most crucial parts of the migration process. 

Segment testing involves actually using each area of Vision to process your converted data 
before going ahead with the final conversion. This gives your firm an opportunity to evaluate the 
results of your migration decisions and the data conversion. It can also enable others in your firm 
who will be using Vision to begin becoming familiar with the system. 

Segment testing includes both data testing and process testing to help you answer the following 
key questions: 

 Data testing: Was the conversion setup done correctly? Are you happy with how the data 
converted? 

 Process testing: Can you recreate all of the major process cycles (billing, payment 
processing, reporting) in Vision? 

Typically the segment testing period lasts for a few weeks, but at some large firms it can span 
several months. 

Segment Test Plan 

In preparation for segment testing, Deltek will help you create a test plan and work with your staff 
as they put Vision through its paces. Besides ensuring that Vision does what it's supposed to do, 
the test period gives your staff an opportunity to become comfortable with the Vision environment. 

We can help you design a test plan that covers every important area of Vision. At a minimum, you 
should do the following: 

 Test security and configuration settings by creating users and roles, setting and 
modifying various configuration options, and creating custom tabs, fields, and labels. 

 Test Info Center records by adding, modifying, and deleting data and/or records within 
each Info Center. 

 Test the transaction entry process by entering sample data in Vision for each enter of 
transaction (for example, timesheets, expenses, invoices). 

 Test the posting process by posting sample transaction entries and analyzing the results. 

 Test revenue recognition by completing a test run and reviewing the results for projects 
that have data posted to them. 

 Test overhead allocation by completing a test run and reviewing the results for projects 
that have data posted to them. 

 Test report generation by running various reports and analyzing the data in the reports. 

 Test interactive billing by processing various transactions using sample projects. 

Processing in Vision should yield the same results as processing in Sema4. Investigate and 
resolve any significant discrepancies before your firm begins processing live on Vision. 

Back Up Your Vision Test Database 

Before you begin segment testing in Vision, we recommend that you create a backup of your test 
database. This gives you the option to restore your data at any time during the testing process, if 
that becomes necessary. 
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Contacts Conversion 

Deltek Sema4 contacts from Project Setup, Client Setup, and Vendor Setup are converted as 
Deltek Vision contacts. 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the converted data in Vision, click Info Center » Contacts on the Vision Main Menu. 
Most contact information displays on the General tab. You may see multiple entries for the same 
contact, if the contact was entered in multiple Setup screens in Sema4. 

Last Name 

Because a last name is required in Vision, the value in the Contact1 or Contact2 fields in the 
various setup dialogs of Sema4 are separated into First and Last name portions. For example, if 
you entered a contact1 value of Joan A/P in a Sema4 Project Setup screen, A/P is transferred as 
the Last Name of the contact in Vision.  

Addresses 

The contact’s address information originates from the setup screen which the contact is 
associated with in Sema4.  The address in Vision will be noted accordingly as client address or 
vendor address for example. 

Contact Status 

All contacts from Sema4 are converted to Vision with a status of Active. 

System File Information Conversion 

Only a few of the fields from the System File in Sema4 convert to Vision. This section reviews 
those fields that do convert. 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the converted Business Management Control Information data in Vision, do the following: 

To View Procede as follows from the Vision Main Menu 

Invoice numbering Click Configuration » Billing » General, and click the General tab. 

Custom Fields Any custom field given a label in the System File of Sema4 displays on the 
S4 tab of the corresponding Info Center.  Project, phase, and task custom 
fields all display in the Project Info Center’s S4 tab. 

Additional Pay 
Categories 

Click  Configuration » Payroll » General, and click the Other Pay Setup 
tab. 

Invoice Numbering 

If Invoice Numbering on the Project tab is set to Company-wide, the invoice number option in 
Vision is set to Company Wide. 
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If Invoice Numbering on the Project tab is set to by Project, the invoice numbering option in 
Vision is set to Project. 

Custom Fields 

All of the Custom Fields established in the System File of Sema4 convert to Vision along with 
their contents. Prior to conversion, all special characters displaying in the names of those Custom 
Fields are removed; otherwise, they are converted as-is. An S4 tab in the corresponding Info 
Center in Vision stores those fields and their values from Sema4 for the individual records.  

For example, if you have a custom field under the project tab in the System File called Sq. Ft., it 
would be modified to Sq Ft and after conversion could be found in the Project Info Center on the 
S4 tab. 

Additional Pay Categories 

If you are converting payroll, any Additional Pay Categories established in the System File of 
Sema4 on the Payroll tab are converted and display as Labels in Vision under Configuration » 
Payroll » General, on the Other Pay Setup tab. 

Accrued Benefits 

Indirect Projects with the Accrue Time check box selected are converted to benefit accrual codes 
in Deltek Vision. Accrual schedules are also converted to Vision. 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the converted time-off code information in Vision, do the following: 

To  View Proceed as follows from the Vision Main Menu 

Benefit accruals Click Configuration » Accounting » Time Analysis and click the Benefit 
Accruals tab. 

Accrual schedules Click Configuration » Accounting » Accrual Schedule. 

Time Analysis headings 
and setup information 

Click Configuration » Accounting » Time Analysis, and click the Time 
Analysis Headings and Time Analysis Setup tabs. 

Indirect Project ID and Short Name 

The indirect project IDs and short names for those indirect projects marked as accruing time are 
converted as benefit accrual codes and descriptions.  

In addition, the conversion creates an overhead project in Vision for each converted indirect 
project that accrues time and then adds a row for each of those projects on the Time Analysis 
Setup tab of the Time Analysis & Benefit Accrual form.  

Maximum Hours 

Any limit designated in either the Cap Max or the C/F Max fields in Sema4 are converted to the 
Maximum fields and the Carry Over Limit fields respectively in Vision on the Benefit Accrual 
Setup tab of the Time Analysis & Benefit Accrual form  
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Accrual Schedules 

Accrual Schedules in Sema4 are converted to Accrual Schedules in Vision under Configuration 
» Accounting » Accrual Schedule. They display nearly identically except that rather than 
tallying the accrual rate in Hrs/Month, Vision calculates the figure into a corresponding Hours 
Per Year field. 

Employees Conversion 

The conversion creates employee records in Deltek Vision for all employees set up in Deltek 
Sema4. 

If you have any employees for whom you’ve entered normal AP invoices, the conversion creates 
a vendor record for them in the Vendors Info Center as well as creating the employee record.  

There are no related migration decisions. 

Reviewing the Converted Data 

To view the converted employee information in Vision, click Info Center » Employees and 
go to these tabs: 

 General 

 Personal 

 Accounting 

 Payroll (if applicable) 

Name 

The First Name, Last Name and Middle Initial are converted as the employee’s name in Vision.  
The Long Name from Sema4 is converted into the Preferred field in Vision. 

Staff Type 

If you choose to convert staff types as labor categories, each employee is assigned the labor 
category created from his or her default staff type. 

If you choose to convert staff types as Vision labor codes, each employee is assigned the labor 
code created from his or her default staff type. 

Pay Type 

If you process Payroll in Sema4 and Vision, employees whose Sema4 pay type is Salaried are 
assigned the Salary type in Vision on the Payroll tab. Employees denoted as Hourly in Sema4 
receive the Hourly Type designation in Vision.  The Job Cost Rate on the Accounting Tab in 
Vision and the Pay Rate on the Payroll tab in Vision both populate with the Hourly Pay Rate 
from Sema4. 

Hours/Day 

The Hours/Day field in Vision on the Personal tab fills in with your selection from the Hours Per 
Day choice you made in the Converting Employee Information dialog in the Data Migration Tool. 
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Overtime Cost Multiplier 

Overtime multipliers designated by the employee’s Default Overtime Code in Sema4 become 
job cost overtime percentages in Vision.  

If you have Vision Payroll, they also become pay rate overtime percentages. 

Historical Rate Tables 

The historical rate tables for pay rate, job cost rate, and bill rate in Sema4 are converted into 
separate tables on the S4 tab of Vision. 

Department 

If you convert Sema4 departments to Vision organizations, each employee is assigned to the 
Vision organization to which the employee’s department is converted. Otherwise, the department 
converts into a field on the S4 tab called Emp Dept. 

Target Ratio 

The entry in Target Ratio in Sema4 is converted to the Target Ratio in Vision.  

Addresses, Email, Phone. . . 

All of the information on the Address section of the Main tab in Sema4 is converted to equivalent 
data items in Vision. 

Notes 

Any notes on the Notes tab from Sema4 display in the Memo field on the Personal Tab in Vision. 

Dates 

The Start Date from Sema4 converts as the Hire Date in Vision and any End Date in Sema4 
converts as the Termination Date in Vision.  Last Raise Date converts as Raise Date. 

Payroll Taxes, Direct Deposit, and GL Accounts Information 

A master tax table of all deductions converts into Vision under Configuration->Payroll-
>Withholding Codes.  Each employee also has their deduction table from Sema4 convert to 
their employee record Payroll tab and the Withholding grid includes their unique amounts, 
percentages, filing status, exemptions, additional amounts and limits if any existed on their 
Sema4 deduction lines.  Their direct deposit information converts to the Accounting tab of their 
employee record in a Direct Deposit grid. 

Invoice Design Conversion 

You have the opportunity with the Data Migration tool to establish and convert each invoice 
design in Sema4 to a corresponding set of billing terms in Vision.  The invoice design itself does 
not convert; however all the projects assigned a particular invoice will receive a particular set of 
billing terms if you choose to define them in the data migration tool. 

Related Migration Decisions 

For each invoice design, you may elect to designate a default set of labor, fee, consultant, 
expense and miscellaneous billing terms in the Converting Invoice Designs to Vision Billing 
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Terms dialog.  If you skip this dialog in the data migration tool, none of the projects will be set up 
with billing terms related to their Sema4 invoice design. 

Reviewing the Converted Data 

To view the converted data in Vision, click Billing » Billing Terms on the Vision Main Menu. 
Select the Vision project for which you want to view the Billing Terms.  The Labor, Exp/Con/Unit, 
Fees, Misc, and Billing Backup tabs look nearly identical to those same tabs as they display on 
the data migration tool. Your data migration selections for the invoice design that was assigned to 
the project in Sema4 should display here just as you selected them in the data migration tool.  
From Interactive Billing in Vision, you can preview an invoice to see how those billing term 
choices translate onto the printed page. 

Clients Conversion 

Deltek Sema4 clients are converted to clients in Deltek Vision. 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the client information in Vision, click Info Center » Clients on the Vision Main Menu.  

Addresses, Email, Phone… 

Most of the information on the Main tab of the Client Setup dialog box in Sema4, along with any 
information from the Notes tab is converted to equivalent data items in Vision on the General Tab. 

Contacts 

Contact 1 and Contact 2 from Sema4 convert into the table on the Contacts tab of the Client Info 
Center in Vision as well as displaying in the Contacts Info Center. 

Projects Conversion 

All Deltek Sema4 projects are converted to Deltek Vision projects (WBS1). 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the converted project information in Vision, click Info Center » Projects on the Vision 
Main Menu.  

Project Work Breakdown Structure 

This topic only discusses the conversion of information from Project Setup in Sema4.   

Project ID and Name 

The project ID from Sema4 becomes the project number in Vision unless the ID contained 
apostrophes or blank spaces. As these characters are not allowed in project numbers in Vision 
they are removed prior to conversion. 

The Project Long Name from Sema4 converts into the Short Name and Long Name field in 
Vision.  The Project Long Name in Sema4 may be truncated in the Short Name field in Vision 
due to the maximum length of the Short Name field. 
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Status and Type 

Active projects in Sema4 convert as Active in Vision. Inactive projects in Sema4 convert with a 
Dormant status in Vision.  

Projects marked as a Proposal projects in Sema4 are converted to Vision with a Charge Type 
of Promotional unless you have entered sales journals for that Proposal project in Sema4. 
Since only Regular projects may produce revenue in Vision, Proposal projects in Sema4 that 
have been billed are converted with a Charge Type of Regular in Vision. Indirect projects in 
Sema4 are converted with a Charge Type of Overhead in Vision. 

Client 

The project’s Client ID in Sema4 is converted as the Primary Client in Vision. The Client 
Address is set to the default that converts to the Client Info Center. If there is an alternate Billing 
Address in Sema4, it is set as the Billing Address on the Accounting tab in Vision. 

Principal and Project Manager 

If you’ve assigned a principal to a Sema4 project, the principal is converted to Principal on the 
General tab of the Project Info Center. The project manager specified in the Project’s Billing tab is 
converted to Project Manager on the General tab of the Project Info Center. 

Project Type 

The Project Type in Sema4 converts to Project Type in Vision. 

Other Billing Tab fields 

Some fields on the Billing tab of Sema4 Project Setup have no direct correlation to any field in 
Vision.  These fields, such as Billing Schedule, Department, Office, Invoice, and Default 
Multipliers are converted as custom fields on the S4 tab in Vision along with the Custom Fields 
set up for Projects in the System File of Sema4. 

PTD tab and Notes 

The Budget and the Contract fields from the PTD tab in Sema4 are also converted onto the S4 
tab of the Project Info Center in Vision. Also, all Notes from the Note tab of Project setup are 
converted into WBS Invoice Notes fields on the S4 tab.  The Fee Contract is also converted into 
the Compensation field of the Accounting tab in Vision. 

If you chose to convert particular invoice designs into fee billing terms of Over-all percent 
complete or Percent Complete as Fixed Amount by Phase, the projects assigned those invoice 
designs in Sema4 will also have the Percent Complete and Billed to Date fee figures from the 
PTD tab display on their Billing Terms Fee tab in Vision. 

Phases Conversion 

The Deltek Sema4 phases are converted as WBS2 in Vision. 

Related Migration Decisions 

There are no related migration decisions. 
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Reviewing the Converted Data 

To view the converted billing group information in Vision, click Info Center » Projects on the 
Vision Main Menu. From the collapsible project tree, select the phase you wish to review. 

Work Breakdown Structure 

This topic only discusses the conversion of Phase Setup information.  

Phase ID and Name 

The phase ID in Sema4 becomes the phase ID in Vision unless characters such as apostrophes 
or spaces were used in the Sema4 ID.  Since Vision does not allow either apostrophes or spaces 
in the phase IDs, these are removed from the IDs before conversion.  The Phase Long Name is 
converted to the Short Name and Long Name fields in Vision, though it may display as truncated 
in the Short Name field of Vision. 

PTD Figures and Notes 

Any Budget and Contract numbers entered in the Sema4 PTD dialog convert into fields on the S4 
tab of Vision. Additionally the Fee Contract displays in the Compensation field on the 
Accounting tab in Vision. Any Notes from the Notes tab of Phase setup display in the WBS Notes 
Memo fields on the S4 tab of Vision. 

If you chose to convert particular invoice designs into fee billing terms of Percent Complete as 
Fixed Amount by Phase, the projects assigned those invoice designs in Sema4 will also have the 
Percent Complete and Billed to Date fee figures from the PTD tab display on their Billing Terms 
Fee tab in Vision. 

Other Fields in Vision 

Project Manager, Principle, Project Type, and Primary Client fields are not only located on the 
project level in Vision, but also on all sub-levels.  Since Sema4 phases did not have separate 
fields for these values, the values for Project Manager, Principle, Project Type, and Primary 
Client for phases in Vision are derived from those fields on the Project Setup of Sema4.  

Tasks Conversion 

You have four options for converting the Deltek Sema4 tasks: 

 You can convert tasks marked as fee tasks to a work breakdown structure level (WBS3). 

 You can convert tasks marked as fees to Vision labor codes. 

 You can convert tasks marked as expense to a work breakdown structure level (WBS3). 

 You can choose not to convert tasks at all. 

If you choose to convert fee tasks, you may only choose one of the two fee task options. 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the converted task information in Vision if you convert tasks to a WBS level, click Info 
Center » Projects on the Vision Main Menu, select a project, and then expand the sublevels of 
the project in the upper left corner of the form until the tasks are displayed.  

If you convert phases as labor codes, you can review the codes by clicking Configuration » 
Accounting » Labor Codes on the Vision Main Menu. 



Chapter 4: Preparing to Go Live on Vision 

 

Migration Guide 92 

 

If You Convert Tasks as Labor Codes 

If you convert fee tasks as Vision labor codes or as one level of your Vision labor codes, 
these are the results: 

 None of the fee tasks display in the work breakdown structure. 

 The task IDs and descriptions are converted to Vision labor codes and descriptions as 
you specify in the Establish Vision Labor Codes dialog. 

 Tasks for converted time records are reflected in the Vision labor codes assigned to 
those records. 

If you Convert Tasks as Part of the Work Breakdown Structure 

The Sema4 task ID becomes the task ID in Vision unless characters such as apostrophes or 
spaces were used in the Sema4 ID.  Since Vision does not allow either apostrophes or spaces in 
the phase IDs, these are removed from the IDs before conversion. The Long Name in Sema4 is 
converted for both the Long Name and the Short Name, though it may display as truncated in 
the Short Name field of Vision. 

PTD Figures and Notes 

Any Budget and Contract numbers entered in the Sema4 PTD dialog convert into fields on the S4 
tab of Vision. Additionally the Fee Contract displays in the Compensation field on the Accounting 
tab in Vision. Any Notes from the Notes tab of Phase setup display in the WBS Notes Memo 
fields on the S4 tab of Vision. 

Departments Conversion 

If you use departments in Sema4, you can convert departments as: 

 Vision organizations and/or 

 Vision labor codes 

There are no related migration decisions. 

Reviewing the Converted Data 

If you convert departments as organizations, you can review the organizations by clicking 
Configuration » Organization » Codes on the Vision Main Menu. 

If you convert departments as labor codes, you can review the codes by clicking Configuration » 
Accounting » Labor Codes on the Vision Main Menu. 

Department ID 

If you convert departments to organizations, the portion of the account structure that you 
designate as representing the department becomes the various department IDs. If you selected 
the Use Department Field to Aid in Organization Default check box on the Sema4 
Office/Department to Vision Organization mapping screen, then the Department ID also displays 
as the Organization ID in the Project Info Center General tab or as part of the Organization ID if 
your Organization code has multiple parts. 

If you convert departments to Vision labor codes, the department IDs are converted to Vision 
labor codes as you specify in the Establish Vision Labor Codes dialog. 
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Department Description 

If you convert departments to organizations, the department description converts as you define it 
in the Naming Organizations dialog from the data migration utility.  

If you convert departments to Vision labor codes, the department descriptions are converted to 
Vision labor code descriptions. However, you can change the ID and the Description in the 
Establish Vision Labor Codes dialog. 

Manager 

The department manager is not converted. 

Inactive Departments 

If you convert departments to labor codes, all departments, inactive as well as active, display in 
the Establish Vision Labor Codes dialog box. However, by mapping your inactive departments to 
one dummy Vision ID, you can essentially remove them from Vision.  

Staff Types Conversion 

You have three options for converting Deltek Sema4 staff types to Deltek Vision: 

 You can convert staff types to Vision labor categories. 

 You can convert staff types to Vision labor codes. 

 You can convert staff types to both labor categories and labor codes. 

There are no related migration decisions. 

Reviewing the Converted Data 

If you convert staff types as labor categories, you can review the labor categories by clicking 
Configuration » Accounting » System Settings on the Vision Main Menu and going to the 
Labor Categories tab. To see the labor categories assigned to individual employees, click Info 
Center » Employees on the Vision Main Menu and go to the Accounting tab. 

If you convert staff types as labor codes, you can review the codes by clicking Configuration » 
Accounting » Labor Codes on the Vision Main Menu. To see the labor codes assigned to 
individual employees (if any), click Info Center » Employees on the Vision Main Menu and select 
the Time & Expense tab. 

Staff Type ID and Description 

If you convert staff type to labor categories, you map each staff type to a labor category number 
and description in the Establish Vision Labor Categories dialog.  These IDs in Vision must be 
numeric, so if you used characters in your Sema4 staff types, remapping them is necessary. 

If you convert staff types to Vision labor codes, the staff type IDs are converted to Vision labor 
codes and labels as you specify in the Establish Vision Labor Codes dialog. 

Employee Staff Types 

If you choose to convert staff types as labor categories, each employee is assigned the labor 
category mapped to his or her staff type. 

If you choose to convert staff types as Vision labor codes, each employee is assigned the labor 
code created from his or her staff type. 
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Category Conversion 

Converting Sema4 Categories for use in Vision is optional. There are three possible uses for 
Sema4 Categories when converting to Vision: 

 Convert expenses using the accounts associated with the Sema4 Categories. 

 Establish a Unit table in Vision based off your Sema4 Categories. 

 Establish Vision Billing Expense Categories based off your Sema4 Categories. 

You can choose to utilize any, all, or none of these conversion options. 

There are no related migration decisions. 

Reviewing the Converted Data 

If you converted expenses using the accounts associated with the Sema4 Categories, the best 
place to review the results of the conversion is through Interactive Billing. For those projects that 
had multiple categories of reimbursables to invoice, when invoicing expenses by account, the 
division of reimbursable charges on the invoice should reflect the various accounts associated 
with the corresponding Sema4 Category. 

If you established a Unit table in Vision based off your Sema4 Categories, to view the units, click 
Info Center » Units on the Vision Main Menu, and open the Unit table. All the categories you 
defined as converting to units are in that unit table. The ID from Sema4 becomes the Unit ID in 
Vision and the Long Name in Sema4 becomes the Unit Name.  

If you established Vision Billing Expense Categories based off the Sema4 Categories, you may 
review them by going to Billing » Billing Rate Tables » Expense Categories. The Sema4 
Category Long Name becomes the Description in Vision and the mark-up converts over as the 
multiplier in Vision. 

Vendors Conversion 

Deltek Sema4 vendors are converted to vendors in Deltek Vision. 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the vendor information in Vision, click Info Center » Vendors on the Vision Main Menu.  

Addresses, Email, Phone… 

The information on the Main tab of the Vendor Setup dialog in Sema4 is converted to equivalent 
data items in Vision. 

Net Days and Discounts 

If a vendor in Sema4 is assigned a value in Net Days on the AP Setup tab, that number of days 
is assigned as the Payment Terms for the vendor in Vision. 

If you have vendors in Sema4 that are assigned Discount Days and a Discount Percentage, 
the discount rate and discount days are converted for those vendors. 

Inactive Vendors 

An inactive vendor firm in Sema4 is converted to a “dormant” vendor in Vision. 
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Chart of Accounts Conversion 

General ledger accounts in Deltek Sema4 are converted to GL accounts in Deltek Vision based 
on the conversion setup information you enter in the Accounts Mapping dialog of the data 
migration utility. 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the converted accounts in Vision, click Info Center » Accounts » Chart of Accounts on 
the Vision Main Menu. 

Account Number Structure 

You define the structure of your Vision account numbers before the conversion using the 
Converting the Chart of Accounts dialog in the Data Migration Utility. 

Basically, only Sema4 main accounts are converted to Vision. If you have a departmentalized 
account number structure in Sema4, you normally map all accounts with the same main account 
to one Vision account. In Vision, you use organizations to replace the financial reporting function 
of the other account divisions in Sema4. 

Account Number and Description 

The Sema4 account numbers and titles provide the default Vision account numbers and account 
names, but you can change those in the Sema4 Data Migration Accounts Mapping dialog when 
you map accounts. 

Posting Status 

Active accounts are assigned the Active status in Vision, and inactive accounts the Dormant 
status.  

If multiple Sema4 accounts are mapped to a single Vision account and at least one of theSema4 
accounts is open to posting, the Vision account is given the Active status. 

Notes 

Any notes you’ve entered for an account in Sema4 are converted to a custom field on the S4 tab 
in the Chart of Accounts Info Center in Vision. 

Accounting Periods and Account Balances Conversion 

The conversion creates fiscal periods in Deltek Vision based on your designation in the Number 
of Fiscal Periods field on the data migration tool in the Establish Vision Accounting Periods 
dialog. Periods are only created in Vision for periods with activity in Sema4 as well as through the 
period cut-off date indicated on the Establish Vision Accounting Periods dialog. 

There are no related migration decisions. 

Reviewing the Converted Data 

To view the converted accounting periods in Vision, click Utilities » Period Setup on the Vision 
Main Menu. 
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Fiscal Year 

You designate your fiscal year in the same Establish Vision Accounting Periods dialog with the 
Fiscal Year Start Date and Fiscal Year End Date. 

Account Balances 

The account accrual balance in the Balances tab from Sema4, and the cash balance if you 
choose to convert Cash Basis, converts as your balance in Vision. 
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